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HFETLORE: NEESHHEROBHOMEICRTSNTVSER. TNE
NONEBRSEER BB TESIIIHBYEL FEET—FTIX. XVATES
VI THIELTEET,

aA—RFATFTTS5L

TIAILbDA—FR24K: Dorico Ma—RE A7 S LD AR IKREZRIRT 55,
ARETHNIEA—T oo z47, F5THWNVBE B XBEELN\L (T2 EEL. &
OGN 1—,ENBL AT IETESRYEIELET,

=V

ATV INT R DR S (5854 T2 a2 (Notation Options) IOTa>T
2o (Condensing) IDR—JIZH IKTBRBEEORT/ERTOLES
(Accidental visibility overrides)1A 7L arhBMEn, v T ENTIVE
WEEDIEEREES (Accidenta) 1 F7ANTADEEIL TV a5z
—TEBKIITHYFELL =,

IH9RTLyiaryS

BEATLavOLESER: TORT LY a2 EHALTEEA T avn
LEEEFFFRTELLSIHYFELE, NIZKY . HHOURSATS =T, EIC
[ERICHIURSATI)—NDINYFEICBBLIBEA T avE#ERTEET,

B4 (Play)l » TTZORTLyiarIvF (Expression Maps)JIZ#LIBEL
Farm L EBEER (Playback Options Overrides) ]2 a3V AEBMENTEH
Y, ZZICIXIFEALEDBEA T IVNRTINTVET . TNETNRDRTIFRA
VFEAUICTHILET. COIYRTLYavIvTTLEEESTEA TV EEE
TEFET . RTRINTWSTIAIIMENREDEELY . EROIBEAL T3
(Playback Options) I1# 4/ 7BRYJ [CRRENFET,

A—HY—A242—TJx—X: THB&E (Play)l] » TTH9RFLydavveyr
(Expression Maps)1Tl¥+¥> 1)L (Cancel)1%#5") v 3 %h [Esc] T &,
EREWETOINMNREANBTERETINEHR T AV E—UNRTEIND LD
[ZHYELT=,

NotePerformer: NotePerformer BA TV 7L —r2ERT 3700002 E.
(B4 AT 3> (Playback Options) @ NotePerformer THRX T w3y
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@ steinberg

[SE)E EEENRTEIN, TNOAEIEHEERLLIICEBESINSLSITHYEL
Tz

RLEYFDEHRD/—F: TEE (Pay)l » TZTH9RTLyiarey
(Expression Maps)1DTTHORTLvyiarv ST —4 (Expression Map
Data) 172 avIZHFHIILLITRACEYFOEBD /—rZEEFA (Allow multiple
notes at same pitch)1A 7 avhBmahn, RLEYFDERD /— A M) H
—INIGBICBETNAATRETELLSIZTEINEINERETESLSIC
TYFELT=,

Toav DA Ty BEBECARBESLEDMN A—ICRELET 3> (MIDI
aAPA—5—F O PX—RAYF/—MEE) MBEBIZERLTHIEyvbEhd K512
BYFELIz, ChIZKY, RLHEIZH AT RADA Ty RBEN  EELLEFFH
LIREHKET HLIITHYET,

BROTIHIEDTaL—ay: HRITERSNETODIIMTIE R5—HMT
WTWEWEROTI4ILEDOBETaL—YaviEi#shizTaL—arv o
95%., RS —AMFLV=ERDIHE (L 105% IZ2YELT=,

BEDER: TBEBZEOBEDRE®EE (Edit Playback Playing Techniques)
FAT7AT DEMNTBEMRERE (Edit Playback Techniques)JIZEEI.
TB4E (Play)I1A=a—F &M% E (Engrave)l » IEZEHE (Playing
Techniques)IDTRE (Edit) IRIUMNET VA TESKSITHYFELT:,

#B=F{+E{EF (Figured bass)

EFE: [Shift]+[G] TRIRSNAMFHEEEDRYTA—/I—IZ 19 FTOHF
EANTEDSSIICHYFEL, ChICKY  EER LA V32— TZ2HASER) TA
NTCEBEDRAL VT EROTIHEEIZEFTT  RICE->TIX. 2 BHTIIAL
RODAVF—TICBL-HFEFERAL TRV VTG ATEEEEZRTTS
CEEERTDBENHYET . COEE. BFRFIBFBYICRTRSINFERA, =&
ZIE, EMSTIZEHED 19, 10, 8 ELVSHMFDRFYIIE. MHYIZ 5,.3.8 LR
SNBIENHYET , Dorico TTCNERUNBRET/IR T BICIE, TO/T1/3R)L
DIHFFEEEF (Figured Bass)IV IIL—TTHLWVESFEEZHEEROLSICE
7= (Show compound intervals as simple)17O/N\T4ZAIZLFET,

Y AR LAV ER—ILR: TORTANRIVEFERLTR—ILRERIE Y ARY
23 DTaAL—avEERTHNDHYIZ, [Shift]+[G] TRIRSNLSHFFE
BEDRYTA—N—DAATFRAMNIETEEBMTSHET, ZORYTH—
N—DHR—ILRFE=IEH AR 3o DT aAL— 3V F R ETESIIIHYE
L7=,

R—=ILRDTaL—a DG EIETaL—avORiIzld=1%EBML., Y AR T3
YDTaAL—2avDEEFTaL—2av DRI r=1%FEMLES, TaL—3>
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@ steinberg

X 4 HEFORTERDLIY (#Bl: [d=21F(4r1=15]). TOHBEDEZENT2L
—2avELTHRELRY (il Td=notelFt=(Elr=notel). ZDLEDEEDT 1L
—2aVDRPELTHEELEZYTEFT Bl EENE2EROBZS. Id=1/2n1(F 4
NEH 2 DRDTaAL—2av OFR—ILRSAVEERLET), BEITHL T, h—
IWREYZRRU L aVvBADTaAL—2avERETHELTEET (B 5, 4->3
d=4r=21),

R—ILRSAUDGE: THEF T3> (Engraving Options) 1D M F (HEEE
(Figured Bass)IDR—IIZHBITH A (Design) 1ty avIz#H LLF—ILE
SA2DOKFELIE (Horizontal position of hold lines) A7 avhEiEh, 7k
—IESAUZEZEDHR—ILEDABERASNIREDEFDOERI TR T 50, RED
ERADTaAL—2ar DR THETTHIEITMEHRETESLIITRYFEL,

7th O—FDERDETE: ZLBFERIHFEANTLHE MIHBRETEHFIFUH
7th A—REIBELTWDEHTESINETH., CHBICEF T IR THLLERY
FEA COFIERREED KRBT HENEERETAHLNA T avnI &5
AHFATS 3> (Note Input Options) |DTEFE{EE (Figured Bass)IXR—I(Z
EBmEhEL,

RKFOHF: BFEERATHIEENF KR ONLLMERIZ. EDHFEZHL
BAHARDNRRENDLIITHRYFELT =,

RS EDEE: HFOEADEEIESDKEARDEENREIN, HBT
DEFOERMNLEN=HIZHDITOERIESHIHIMEINSEENTEESINDZE
WY ZELE (EBLEFD 4+ O EIZBHTRMGEFTFaSILHG V= 6 B S5

a%E),

BREERDAE ERITORFICHLTRGEDIN—Z VT HFEERIRTESLIIC
BYFELT=, MHARETIE. BFELDERESABELTRESNSEIIC. K
FOAEOEEAMOMBENEEBMIZETFoNET  HiRESh TS EE TR
FERASN TSI 1 D2DAEELT, LFEFTOTOERKL S LDEREME
Y H=BIC RS DKFEMEZARET ODTIHLGL BFOTOEEAM
DEREEET HZEENHYET, Dorico 3.5.10 IZIXEDHEMNEESNTLVE
ER

ZD 2 D2DFEEVVEZSICIE. TEHEREBDAZE (Collision avoidance
approach)1#T{THZILIT5 (Separate rows vertically)] (FI#IERE) F=1&
RS Z B8 (Move accidentals) JICERELET . &I, THMKRE
(Advanced Options)1H 7o avIZld, BREESHAEEMITON =3 F(ZHE
FREKBERESOEEARDOBEEH AT IELHETH-HODA T avr A
BEShTVET,

sus7: [#Z4 73> (Engraving Options) |DI = &E{EF (Figured Bass)]
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@ steinberg

DR—UIZHBIEEF (Figures)ltoavI#H LLTsus7 O (Appearance
of suspended sevenths) 147 avhBmEh, EED 3 E LD FREFHRM
[CRERTAINEINTBIRTEDHLIIHYEL-,

BEET-FOHE: FETFCTR—IFSAUEEEAMICBEITESLIITRY
ibf:o

Ry TA—/\—DHEIRFE: [Shift]+[G] TRERSNDHFHEEFTORYTAH—/—
2. LT OIEREBXEANTEES,

AL R
X#HX, #ts RTINS —T
X, ##, ds FITNv—T
#.s —7
b, f 759k
bb. db FITILITZVb
bbb, thb rIZTILTSVE
N FTFaIL
+ FELEF
+E T
d T43=wia
u BRMIICER SN
>, N PRRUay (f: 4->3, 4_3. 4~3)
RorcVov,? ZOHEIZOHIBFELF TS avIZHES (Follow Engraving Options) %3]
0.0,! COHFIZOH ANRBIZFDEEHES (Follow input literally) |Z 38
<x>, {x} FEIMCHEENZBFZIERTRIZTS (Bl 7->6, <3>)

FEEFFEAL.THEAF T avIZ#S5 (Follow Engraving Options)1Ef=[&
TAHRABIZFDFEEHS (Follow input literally) 125 E L THER SN =-BEFED
BFHAESBETATLERET S5HE. Ry TA—N—ZHELEBICEFFE
BET7ATLONENFHRETEREINSENBNKS Ry TH—N—HNOT
FRMDFERBICM2)FET N EEEBMINET,

54>

¥reig: 148 (Engrave)] » IS4V (Line Annotations)J# 4 7RJ #ERAL
T. AV DORBMEE. PE. B THEDTHFAM—RDERICHIEZEMTE
BEINTHYEL, T TONTAZFERATEESA VT LORREEBMTEET,

CEURTA: CGSURTADHFREDKSEIRE TEDIIIGYFELz, ThITKY,
HOBARRICKBYBUHCES. HAVIEZTDFEDREERTEES,

FIMDOEE: EERICRTRSNSGTIAM—ADIAVIERE. BEROLTET
THGERDORAIEFSMUIZLEE TEDRIITHRYEL =z, ThIZKY ., 510%
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@ steinberg
ERORMAICEEST & EFRNSIODORFMAIZREELET,
X—h—
Y—h—%EBMNT S1=8HIZ [Shift]+[Alt]+[M] Z#F &, [v—h—%4ER (Create
Marker) 14 A4 705 HRAE. I—h—T X AN EEBETEDLIITHYELT:,

FAT7OT RN EEDEA LI FFRIBDEFEICBEANYRDOMEIZL TR
FYFET,

=XH9—
SXH—LITVRRALVMDRE (Endpoint Setup)1F 4704512, BEE—KRIZK
RENBAVARYILAVR B EADV ARG LAV EERR TSNS ESITHYELT,

BELE
NWARRLNS—: BRIEBITAF—CEMEINDTUIFELIFITIFRANERIZBZEE
TE5E3I2YELT=,

TAURDIIA b BERESITAE—NDITT (Glyph) 12T T, J)I7%HERT
BIFDARAIFE XD ITAEIRETEDLIIZHYFELT=,

A—HF—ALE3—T1—RADHE: BELESITH—DIJYT (Glyph)12T T,
Unicode DaA—KRRAVrDEFRFEEIEIRTESLSIZHYFELEz, ChIZKY,
AVAR=ILENTWDTRTD I+ FDEED Unicode FEM 5T 1) TEERT
EFFET, &Y UTD Unicode DIA—FRRAUME FUTDT)IRIZY—ILFVTE
LTRERENET 5T (Glyphs)1ZTTHUIEZTILD)9HTHE. FDJ)
INBREDEELESITEBMINET,

530
JUvH IR MIEEETIEH. FI—0OZTOMDILYRERIZTVVHURDTH
AMERTRSNFER A EL TRFEPOST Uy YU RETEXE (Glissando text
shown) 17 O/\T1&F I BLMgliss. I THFRAMRREINDKIIZHYELT,

EvF&ETaL—ar ANDRIIEE
HEE REBERECIEYFETaAL—a> AADHIZHRE (Pitch Before Duration
INpU) IDA T3V BN US> TWBIGE . Tal—av AADRIICEYFEiE
ELTWAEEICHBEL-EREBRTORBESEFEALET . £ TaL—Y
AVEEELCRELBEEPERDEYFEERELLGRICLERNBEIND
FOITEYFELT,
RTEDYHR—b FR2—DRTHETEVFETAL—LaV ANDRIIEETES LD
[ZIEYFRLT=,

BEAFT ay
AO/—LD)yY: TEEX T3> (Playback Options) | TANA/—LD) o4
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@ steinberg

DURIZOYR T OIS I UREFERTARIIHEET AL, MIMALHEVATE
BHEEVFNHASNEESIZHYEL

BETUIL—F
MIDI FINM RADIURRARDERTE: VST AV ARYILAVKZINA T, MIDI T
INARADIVRRAVEDEREFITHASIIIHYFELT=,

IVRRAVEDEREDHRSE: TBETUTL—FE#HEE (Edit Playback
Template) IF A 7T ICH LI ZVRFRA VD& E (Endpoint
Configurations)JR2 MBS, TURRA D TE D B IO ZE B PHIBR
EABRBEIIHYELT,

WERE

TanTa: TRETF XL (Alternative text) 170/ T4 DB, IRFEDHERE
XY RMLUIZIERETF AR (Suffix)JIZEBINFELT =,

BEE—F
L—rDH (X BALRELY AV hICE—RFEYVERATH. BEE—FDIY
IDEEHHERFEINDLIITHYFEL =, F=FZL. TR INEFL THEERLV 15
BlIEFINFTEA,

MIDI E=AULS: BEDAVARYILAVNZIFERTS VST A1V ARYILAVRELTE
L=BE . MIDI =AU TIREFDAVARYILAV DB E->TLBIE S H
LWV RRYILAVRES BT AESICEZAYL T ENTCICEHFINALSI2HYE
L=,

F—R—Fa—rhyb: BEE—RDTIAHILIDF—R—F3—rhyrELT,
A Y—ILIZTLIR, IN—hyiarDEEY—ILIZTWIAEIY B THENFELT=,

Jin—4I—o
FHAHRDREAIL: [iBEAF T3> (Engraving Options) D) /N—H )L —%H
(Rehearsal Marks)IDR—2IZ8H5TEHA$R (Enclosure) 1o a> OIEAERD
447 (Enclosure type) AT avIZ#HLnvA T avhBmaEhn, Y/n—3)L3—
IDBEARELTANDODRAREBIRTESLIITHYEL,

BEE—F
AVRARGILAVRE D) yh: TAS VMDD TR TOTL—V—BEHEAEKEIC
JeybddFHLiavorpBmEnEL -, ChlE, MusicXML I7 4 L&t H A
AERIZHIZERTY . COITURFREDESS Dorico DAZa—[Z[ERRE
NTOFERAD REREDF—HR—F3—rhyk (Key Commands)IR—2
THX—R—F a—tAyrZEYETHIENTEET , COFHLLIATURIETAVR
kLA REZED) YR (Reset Instrument Names)1&EFE[Eh, THREE (Edit)1hT
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@ steinberg
TY—OHIHYET

RN
AVT ULV ENTETAT4PD RNy E—DDERIRNIL: THEF T3y
(Engraving Options) IDT§&FXSJL (Staff Labels) IOR— (2 LLavToY
DTENIE=T4 T4 DIV DERF AL (Staff labels for condensed
divisi sections)JA 7T avhBimEhn, avTFoi v ESnt=T4 94D\t —
DICTAV AR ARG TIRIELTA T4 DT N—T2EFERTHLIITIEETE
BEIITYELT =,

ATk
ROTAVYT DIR—IVRSA 2 TiEEA T a2 (Engraving Options) DT FE—_Y
R (Guitar Bends)IR—SDIFH AL (Design) I avcEHLIRY T4 &
DARSA4 O D58 (Pre-bend and re-strike appearance) 47 avhBmah,
BUDBERERN T4V LIRICBEB—EDBEREHRBRAETRL, TNIH
) —RERRTEDLIITHYELT,

RRARUR: TANTAIRRILDFHLWNFE—RIIRUE (Guitar Post-bends)]
GIW—TIZFHILTRRAMUEDERE (Post-bend interval) 17A/ A TohNEME,
TN—RFXE—HFED. 3—TINLGEAFEDBERDGENRURERRTEDSLIIC
BYELF= ThLE BEE—FTRIYILTERBICNEZRE TE, IFE4TY
3> (Engraving Options) 1D FA—ARUE (Guitar Bends) | DR—IIZ(X, T4
IVEDBIBERTET BN —EDA T arhEFzIcAESMTLET,
TIL—RTEEINDGE. U4 B r—THE RURDEENFEEIZ/INEAES
CENKBYFET . BE. TOLIGERIETIERICLST60. BRREICIERSING
WIENBHYFET , RAMUKRIZ 14 BV v—TEERTHLIIIEET BICIE,
TR/IRTANRILDFHLWNINFLE—RIIRUE (Guitar Post-bends) 7 )L—7F(Z
HAMAEDRUR (Microtone post-bend)1 7O/ T4ZFIZLET, AR
DREDLIZ Vo DEBERRSEBIEEE, TEFEA T3> (Engraving
Options) IDI F4—ARUK (Guitar Bends)IR—C DI FH A (Design) 15
AT RAMRUEOHM O ER DN E (Microtonal post-bend interval
appearance) &I E#%IER (Do not show interval) JIZERELET

TFURNSIYHEZHRHRAH: [T7LIL (File)] » T5EHAH (Import)] » [FURFFSY
4 (Tempo Track)1ZFERAL THFESETURDIERE MIDI 774 ILDV SRS AD
5. COEREBRED7O—TIEEEH LW IO—(ZHEAAD D EIIZHYEL,

THAR
PR TIHIWRELTNSTSTREIMINERBETEHUAESHE . [HE
(Engrave)] » 11855 52R454)L (Paragraph Styles) I T EETE5 K324
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@ steinberg

FLl=e TRRNTATLIZEBDNSTSTNEFENTVSEE . ERTATLD
RADINSGTFTIEASNTNSGNST STREAIVITREDBTEESN TN,
EDTFANTATLERSRRTEHENTT .

THRCDEG|: NFT TR VIFH LB ORBEEICHIHEE . BN
H#REHIZ S (Align with systemic barline if at start of system)4+ 73> M
BMEN, TRRNPATLOMELIHEORBMELECIES. EICHBESET
HEED/IMEHIREBIZ DD EIDEIBETEDLSITHYFEL z, BEICIELTTHFRE
TATLIEIZINZEEEZTEDLLS . FILHEBORIBMEIZHI A S (Align
with system start) 170/ TFohBMENELT -,

HLWE—9Y: TJOSzHPDI7ANBERTT D=V
{@projectFileName@} &. 77 M IV BEZBLHMINRERTRTTHN—V
{@projectFilePath@} AA#Frf=IZBMENhFEL=,

F—ooDaAVTHFARAZ2— FFRNIL—LDAVTF AN Z2—DITO—
fRER (Flow Info)l T A= a—IZ, SFEIFHTIO—F S, U EMShFELI-,

THRRAMRYTA—\— TEXAMRERY TA—/\—%FL\=&£Z(Z, Dorico (&7
FAMRERAIFO—ILEZRBICIZAHSET . Ea—RNIZHELESETDHES
':tﬂtuibf:o

A—HP—A28—D1—X

F—AR—R7YEADHE: Dorico DELDFATAY TIE, —EDRT LRIV ZEE
FALT 2 DFERFENULDF T avE2BIRTEDLIITHEL>TUVET, LUETIEIH
SDRAVEXR—HR—FTERETEHLIETEELATLIA, Dorico 3.5.10 Tl
[Tab] #7=[& [Shift]+[Tab] ZERALTINLDREVICTF—HREBEL. EADX
FF—TIN—THDREVEZTYEZ NS ESITHYELF-, macOS TIDEEZE
TESICIE P RTLEREREDF—R—F (Keyboard)IR1>DIYa—bhvk
(Shortcuts) 12T TMaAvrA— LB DT+ —h X BEZF—KR—FTEME (Use
keyboard navigation to move focus between controls)I1Z#4 > IZF HHENHY
Y,

FrL—Ea1a—DAURARIIILAVRSR)L: TL—V—IZHERD A ALY ILA R
NEY LB TENTNRES . FYL—FE1—DFDAUARYILAVRD SR ILD 4%
BIZTL—Y—&EmshsdL5IHZYEL,

BEREL-TO orEREE: 7o) r—arORBEFICTEBRELES
A< xHh%E#E (Recover Auto-saved Projects)]¥ A4 70OY ARRESNS
BEIC.BETEI77MILOEAICEIDOELS. BEIRGFOHBNRTIND
FIITEYFELT=,

F—R—K a—thybDFEFEE: 21— —F—FK—Fa—rhyb®d IJSON T77
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@ steinberg

AILADF—HR—Fa—rhybZE,. FOF—R—Fa—rhyrNERSIN TS
TI2ANEDAVTXRAMIFELDZAVTXIRANTCERLEEE. FO1—F—
JSON Z7A4ILDFHLLILTHFRANBEEINDLSIZHYELT =,
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Issues resolved

@ steinberg

Component

Issue

Articulations

Under some circumstances, attempting to adjust the vertical position of an articulation to bring it
closer to the note would result in it jumping back to its previous position; this has now been fixed.

Audio export

Under some circumstances, exporting multiple audio files from a project could cause Dorico to
hang; this problem has now been fixed.

Ossias above the top staff or below the bottom staff in the system now always join the systemic

Barlines N .

barline if they begin at the start of the system.
Beaming It is now possible to edit the slant of a beam starting on a rest shown without a stemlet.
Beaming Stemlets on single-line percussion instruments now correctly respect the defined gap from

Engraving Options.

Chord diagrams

If two chord symbols showing identical chord diagrams were input with different MIDI voicings, they
would appear as duplicated chord diagrams in the grid of used chords; this has now been fixed.

Chord diagrams

The height of the frame for chord diagrams used in the flow as shown in Engrave mode now
updates correctly when chord diagrams are added to or removed from the grid.

Chord diagrams

Custom fretted instrument tunings now appear correctly in the list of tunings for the chord diagrams
used grid in Layout Options.

Chord diagrams

The grid of used chord diagrams now appears correctly on pages that contain layout-specific
frames.

Chord diagrams

The redraw performance of projects where the grid of used chord diagrams is shown at the start of
the flow has been improved.

Chord diagrams

Turning off the layout option to show the grid of chord diagrams used in the flow on an overridden
page now correctly closes up the gap previously occupied by the grid of chord diagrams.

Chord symbols

The behavior of removing custom chord symbol overrides from the Project Default Chord
Symbols dialog has been improved.

Chord symbols

Under some circumstances, Dorico could crash when closing the chord symbol editor in Engrave
mode; this has now been fixed.

Condensing It is now possible to reliably edit items in condensed divisi passages in Engrave mode.
Condensing Under some circumstances, Dorico could incorrectly show a 2 as the player label at the start of a
system where only one player is actually active; this has now been fixed.

Condensing Under some circumstances, toggling Edit » Condensing could cause player labels to appear
differently; this has now been fixed.

Condensing System-attached items such as repeat markers no longer unexpectedly disappear when enabling
or disabling condensing.

Condensing Condensed staves within the same condensing group of solo players now show their staff labels

grouped if specified in Engraving Options.

Dorico 3.5 N\—>a B
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@ steinberg

Component Issue

Condensing Under some circumstances, a label for one player on a condensed staff could appear apparently
for no reason; this has now been fixed.

Condensing When multiple divisi sections are condensed into a single voice, accidentals are now restated in
the same way as for solo players condensed into a single voice.

Condensin When using Split Flow or Duplicate Flow, condensing changes for divisi sections no longer get

9 reset in the new flow.

Condensing LCj:gda;t%lgg the Player labels paragraph style now correctly causes all existing player labels to be

Condensing Under some circumstances, lines such as hairpins could appear twice in condensed divisi
sections; this has now been fixed.

Condensing In condensed passages where only one player is active, and no rests are shown for the inactive
player, dynamics are now shown below the staff by default instead of above.

Condensing Gradual dynamics and other lines that abut the end of the flow now appear correctly on condensed
staves.

Condensing Lines that cross multiple systems in condensed divisi passages now appear correctly.

Condensing Under certain circumstances, editing the beaming for notes in a condensed layout could cause
Dorico to crash; this problem has now been fixed.

Condensing The horizontal alignment of section numbers for condensed divisi staves is no longer incorrectly
determined by the horizontal alignment of the Staff labels paragraph style.

Cues Changing the Cue labels paragraph style now immediately causes labels for existing cues to be
updated immediately.

Cues Under some circumstances, Dorico could fail to show a clef change at the start of a cue when
different from the prevailing clef; this has now been fixed.

Cues Under some rare circumstances, empty cues could appear in some projects; this problem has now
been fixed.

Divisi Divisi labels now appear correctly once more, and now use the Player labels paragraph style.

Divisi Dorico no longer shows unnecessary clef changes at the end of a divisi passage where one or
more of the divisi staves was already using the same clef as the coming unison passage.

Divisi Creating divisi with a selection containing one or more global items, such as a time signature or
figured bass, now works correctly.
Adding an immediate dynamic in the middle of a group of dynamics at a position that coincides

Dynamics with both the end of one gradual dynamic and the beginning of another no longer causes the
immediate dynamic to be created both at the desired position and at the end of the group.

Dynamics Further improvements to the handling of the transition point for messa di voce hairpins if they
coincide with a barline.

Dynamics Hidden dynamics no longer cause other dynamics in the group to be incorrectly centered between

the staves of a grand staff instrument.

Dorico 3.5 N\—>a B
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@ steinberg

Component

Issue

Expression maps

The Enabled option for the Init switch in an expression map now works correctly.

Expression maps

When editing or importing multiple expression maps in Play » Expression Maps, the list of
expression maps now correctly tracks all maps that are edited, instead of showing the asterisk on
only one.

Expression maps

Problems with the interaction between the new note length conditions in expression maps and the
default playback lengths applied by articulations like staccato and tenuto have been resolved.

Expression maps

The actions specified in the init switch in an expression map are now sent when exporting audio.

Expression maps

Switches that define channel changes are now respected during MIDI export.

Expression maps

An error in the key switch definitions in the HSO Cello Solo expression map has been corrected.

Expression maps

MIDI channel change switches are now included in exported MIDI files, with separate tracks for
each used channel.

Expression maps

Projects with multiple flows using independent voice playback now correctly respect the note
length conditions defined in expression maps in all flows, not only the first.

Expression maps

Key switches defined as “off” actions in expression maps are now correctly output at the end of the
technique range, rather than at the start.

Expression maps

Note length conditions are now resolved correctly for instruments with multiple voices.

Figured bass

Under some circumstances, Dorico could crash when attempting to show a suspension line; this
has now been fixed.

Figured bass

Specifying a cautionary accidental for a figure that is hidden no longer causes the accidental to
appear on its own without the figure, creating the misleading impression of an altered third.

Figured bass

Under some circumstances, when inputting figured bass Dorico could incorrectly calculate the
figures relative to the preceding bass note; this has now been fixed.

Figured bass

Edit» Figured Bass » Force Current Appearance now preserves cautionary accidentals.

Figured bass

Local figured bass items now appear correctly on grand staff instruments.

Figured bass

Figured bass and pedal lines will now appear as expected on the remaining staff of an instrument if
the other has been hidden via a manual staff visibility change.

Figured bass

Figured bass that is in the range of but not coinciding with the start of a deleted note is now hidden
if necessary.

Figured bass

Figured bass is now positioned according to the voice columns on the staff below or above which
the figures appear, instead of sometimes incorrectly using the top staff of the instrument.

Figured bass

Figured bass no longer overdraws on a guitar staff if tablature is also shown.
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Component

Issue

Figured bass

Under some circumstances when a split view is used, attempting to input figured bass would fail;
this has now been fixed.

Graphic slices

The size and position of text in graphic slices in SVG format is now correct for all display
resolutions (Windows only).

Graphic slices

Under some circumstances, changing the format, resolution or export location of multiple graphic
slices, or exporting a large number of graphic slices, could cause a crash; this has now been fixed.

Graphics export

The scaling of text in SVG files is now always correct, regardless of the pixel density of the main
display (Windows only).

Key signatures

Signposts for key signatures now appear if a keyless instrument is present in the system.

Lines SVG graphics used as repeatable music symbols for line bodies are now rotated correctly.

Lines If you specify a text annotation for a horizontal or vertical line using a font style that is not
otherwise already used in the project, it will now correctly appear immediately.

Lines Note-attached vertical lines are now correctly retained when you change instrument.

Music fonts Downward arpeggio signs now draw correctly in Petaluma.

M When you confirm the Engrave » Music Fonts dialog without explicitly changing the selection,
Dorico no longer incorrectly switches the current project to the first music font listed in the dialog.

MusicXML export Under some circumstances .DOI’IC(.) could crash whe_n exporting MusicXML in scores containing
notes hidden by a slash region; this has now been fixed.

Note input When selecting a grace note, the buttons in the Notes panel are now correctly enabled once more.
When using pitch before duration input, Dorico now correctly auditions the pitch of the shadow

Note input note if the option to specify rhythm dot, accidentals and articulations is set to before notes are
committed; otherwise it auditions the selected note.

Note input Changing the barline at the end of the flow using the Shift+B popover no longer incorrectly shows
you a warning about creating a time signature.

Note input When leaving note input, rest input is now always deactivated, so that it is not unexpectedly still
active when you next start note input.

Note input MIDI controller changes recorded during real-time input in projects with repeats are now created in
the correct bars.

Note input Entering multiple notes on tablature via MIDI no longer force all of the notes to be input onto the
same string.

Note input The rhythm dot button in the note input toolbox is no longer disabled outside of step-time input.

Note input Inputting a chord via MIDI keyboard onto tablature now overwrites the entire chord, rather than

only the notes on the strings on which new notes should be played.

Dorico 3.5 N\—>a B

15 R—T Steinberg Media Technologies GmbH



@ steinberg

Component Issue
Note i When using multi-paste to paste a passage containing dynamics and slurs several times along the
ote input ; . .
same staff, the pasted dynamics and slurs are no longer incorrectly linked together.
: Switching from Write mode to Engrave mode after making a marquee selection or performing
Note input . :
Select All no longer sometimes causes some of the selected material to become deselected.
Note input When pitch before duration input and Lock Durations are both active, it is now possible to
transpose the selected note up or down by an octave.
Note input Music input via real-time recording or importing a MIDI file with very short notes no longer
sometimes results in one or more notes being omitted.
Note input When deleting an item and attempting to select a nearby item, Dorico will now select notes that are
closer than a 32nd note before the deleted item.
All noteheads in chords are now correctly positioned against the stem according to their stem
Noteheads .
attachment points.
Under some circumstances, rhythm dots for unison noteheads on a staff line could be positioned
Noteheads . e i
one space higher than necessary; this has now been fixed.
Page layout Items such as lyrics no longer incorrectly affect spacing when the staves on which they appear are
hidden by way of the Manual Staff Visibility dialog.
Under some circumstances, making an edit on one page could affect the vertical position of a
Page layout ; e )
pedal line on a subsequent page; this has now been fixed.
When exporting a master page set, any paragraph style used by the text frames in those master
Page layout pages is now only exported once, avoiding unwanted duplication of paragraph styles when
importing into another project.
p When using lock frame or lock system, any existing break at the end of the affected passage now
age layout S ) o
retains its global space size override, if present.
Percussion Adding a percussion kit to the first empty-handed player created in a completely empty project no
longer causes a crash.
= . The side drum instrument now loads the HSO Snare Combi Key patch, rather than the standard
ercussion .
drum kit.
p : Playback of tabla is now correct both when auditioning selected notes and when playing back.
ercussion
Play mode
Play mode It is now once again possible to edit the velocity of a selected note in a chord; previously Dorico
would always edit the velocity of the first note in the chord, even if a different one was selected.
Play mode Overriding the velocity of a note in Play mode no longer prevents it from being condensed onto the
same stem as another note.
Under some circumstances, Dorico could crash when attempting to paste automation data in Play
Play mode . -
mode; this has now been fixed.
MIDI pitch bend data in projects last saved in Dorico 3.1 is now updated correctly when those
Play mode . ; .
projects opened in Dorico 3.5.10.
Play mode Clicking in the area between the flow selector and the start of the first bar in the ruler in Play mode

no longer causes Play mode to revert back to showing the first flow.
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Component Issue
Switching between voices in the instrument track header in Play mode when independent voice
Play mode ; . )
playback is enabled no longer causes the piano roll height to be reset.
Dynamics and playing techniques now correctly take effect in playback for notes affected by the
Playback . -
swing rhythmic feel.
Playback Dynamics and playing techniques no longer sometimes get out of step following a repeated
section, which could cause either notes to be silent or to play with the wrong dynamic or technique.
Playback Muted sfz dynamics no longer incorrectly have any effect on playback.
Slurs starting and ending on the same note now play back correctly, producing a single legato
Playback . > .
region for the total duration of the abutting slurs.
Under some circumstances, a staccato articulation could become stuck on during playback; this
Playback )
has now been fixed.
The vibrato playback technique is no longer considered an attribute, only applying to the note on
Playback which it appears; it is now a direction, so applies until countermanded by a subsequent technique
change.
Playback The playback of slurs over swung passages has been improved.
Playback The playback of trills when a swing rhythmic feel is active has been improved.
The playback of tied notes with a staccato written at the end has been improved, so that the note
Playback . : )
is not immediately shortened.
Playback JP pf dynamics that do not coincide exactly with notes now play back correctly.
Playback Trills over very long notes played back using generated (rather than sampled) trills would stop at
some point before the end of the notated trill; this has now been fixed.
Playback Dorico now plays back simple measured one-note tremolos inside tuplets correctly.

Playback templates

Invalid characters are now removed from playing template names when they are saved to disk.

Playback templates

Double-clicking an entry in the list in the Playing Technique Combinations dialog opened from
the Expression Maps dialog no longer causes a crash.

Playback templates

Playing techniques are now correctly centred on down-stem longa and maxima notes.

Print mode Dorico really does now choose the Whole page zoom level by default in Print mode.

Properties Under some circumstances, global property changes made on a slur or dynamic would not undo
correctly, or would not appear to take effect if changed more than once; this has now been fixed.

Properties The Properties panel now updates when the active tab changes, so that the correct property

values for the current layout are always shown.

Dorico 3.5 N\—>a B

17 R—=2 Steinberg Media Technologies GmbH



@ steinberg

Component Issue
Properties When changing the number of segments in a multi-segment slur in Properties in Engrave mode,
the selection in the score now updates appropriately.
Properties It is now possible to unset the Prefix and Suffix properties for rehearsal marks as expected.
p . In Dorico Elements and Dorico SE, typing the key command for Engrave mode no longer
roperties . X . d
incorrectly causes the Properties panel to be updated with Engrave mode-only properties.
p . When selecting the same note on a notation staff and in tablature, setting a property such as
roperties - .
adding round brackets now works correctly for both instances.
Tablature Vibrato bar silent pre-dives are now drawn using the correct dashed line rather than a solid line.
Dorico now consistently shows tied-to notes in tablature at the end of bends and slides according
Tablature g ; . :
to the options on the Guitar Bends page of Engraving Options.
When staff notation and tablature are both shown, and tablature is showing rhythms, bar rests now
Tablature . )
show as expected in the notation staff.
Text Changing the name or the parent style for a paragraph style in Engrave » Paragraph Styles now
correctly marks the style as modified and will save the changes when the dialog is confirmed.
Text Changing the alignment of text in the text editor now updates correctly immediately.
Text When a player is attached to or detached from a layout, the layout name token (e.g. in the top left-
hand corner of the first page of a part layout) now updates correctly immediately.
Ties Under some circumstances, a laissez vibrer tie on one system could also be shown as a detached

tie on the following system; this has now been fixed.

Time signatures

Large time signatures centred on brackets now always use the correct scale factor as determined
by the number of visible staves in the bracket, rather than the total number of staves.

Time signatures

When using the option to erase the background behind time signatures, the erasure is how
positioned correctly for large time signatures vertically aligned with the top of the bracket.

Updating

When migrating user settings from an earlier version, Dorico did not correctly update the location
of the AutoSave folder to point at the location for the new version; this is now fixed.

User interface

Under some circumstances, using a shortcut consisting of multiple keys for the instant print
preview feature could result in the print preview becoming stuck on; this has now been fixed

User interface

Under some circumstances, extending a selection spanning multiple pages with Shift+click could
result in Dorico moving the view beyond the extent of the selection; this has now been fixed.

User interface

Zooming in or out after leaving note input now correctly zooms in to the selection, and not to the
position where the caret was previously visible.

User interface

When the Horizontal Lines section of the Lines panel is closed, all of the lines in the Vertical
Lines section now appear correctly.

User interface

Under some circumstances, choosing File » Save All could ultimately result in a crash; this has
now been fixed.
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Component Issue

If Prefer tabs when opening new documents is set to Always on the Dock page of System

User interface : ; : L . e
Preferences, new Dorico windows will now open maximised if specified in Preferences (Mac only).

When macOS is set to Dark Mode and scroll bars are always shown, the scroll bar background in

User interface : . .
the main music area is no longer the same colour as the scroll bar thumb (Mac only).

Under some circumstances, the popover could open in the wrong place when changing a vertical

User interface o . ; . :
split in the project window; this has now been fixed.

Under some circumstances, the popover could open at the very top edge of the page instead of

User interface : .
above the expected staff; this has now been fixed.

Whether or not Dorico would correctly restore the size and position of project windows when
User interface reopening a project was dependent on the order in which projects are opened during the session;
this has now been fixed.

The default key command for instant print preview has been changed from § to ? to avoid a

interf - . . X
User interface collision with the key command for Write » Respell Using Note Below (Portuguese only).

Tokens such as {@flat@} and {@sharp@} are now substituted in flow names when displayed in

r interf i . . .
User interface the Flows panel and in the project window title bar.

If both View » Note and Rest Colours » Divisi Unison Ranges and Notes Out of Range are

User interface ) : R
active, both options correctly take effect in divisi unison ranges.

User interface The list of playback techniques in Play » Playback Techniques is now ordered case insensitive.

Dorico 3.5 N\—av B 19 R—T Steinberg Media Technologies GmbH



Dorico 3.5

@ steinberg

FikeE

Dorico 3.5 N\—C 3V ERE

2020 £5 A18 A

BERDANTEYFETL— a3V DHIIZIERE

Dorico TYW X, AvE1—3—0DF—HR—FK, F£zl& MIDI F—R—F&FERALTHE
BERATYTANTBHEE, CNhETREICEFOEYFEIBEET SR1ICTL—3Y
B RTIDELHYFELIz, ZLDI—HF—IZIXINMNEBIZEREEECONATL
FIHHFC MIDI F—R—FZANICEAL. BEDEREANTLRNSETER
FATT7ON—F=—2RH L THEWNI—HF—ZEoTIK. BHDTaAL—ar %R
R BAENEVFEIEETELIANFELNEEILHYET,

TaL—2a EEYFORIICIEE T HRETIH. BRDANDFT U THRYLYMIE
RENTWNSEEF, BIZTFaL—av BRI EShI=KEETT, DFY. MIDI F
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ElF. BROANBICLDOTEUVEZAONFET . ERDLEIA EvFETal—3
VOHIIEET HEREICLTLADE, AILREDEFEEHRLTANTA-HIZ. HE
DT L= aVICEETESIANBELNLNELILBYET . COBE. TaLl—
2avEEYTFORICIEE T AREICHENYEZASILT, REIERLTWM:=Ta
L—2avIZBBIMICEEINET,

TIHIEDBRFANDIEE: TaL—a EEVFORICIEE T SRELEVFET
AL—avDRIIZHEE T SR EIL. Dorico DFEAPRIINDOTEERIZYIVEZ N
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EvF#% (By default, specify pitch) I TIE. ITaL—a>DRIICIERE (Before
duration)J(SEIV—RRTEASNIZFHLLAR) £=ETTaL—3a>DRICHE
7E (After Duration)] (Dorico T »&ERAINTLWSEEEFEDAE) OLWT M EIEE
TEET,

ZOICTICEES 1 DOEBELGA TV ELT . EVvFETaL—2av DRIICIERE
THBEEDRROEHICEHTIHENHYVET, CNIF. ANTEHEFOZTOMDT
ANTAEHRETIIEFICEETEHLDOTT . BE. BROTRATOTANT1+ (EREF
e T7—T4Fal—ar, F8) (X, RATICEHFELEL I DRISEIRTILEN
HYET, CNIIREERTETIONEYF (Tab—avEEVFORIIZIEE DS
B) THoTH. Tal—ay (EvFETaL—LavDRIEEDNES) THoTH
FE#%TY . LALERERO7ICRELLETHRERS. 7—TaFaL—>av. Bk
U REEETAIENEFELIMGE . TBRBRS. TR 7—T1¥al—a g
% (Specify accidental, rhythm dot, and articulations)1ZIE®RFAHD#E (After
inputting note) JIZERETAET,. FDLSIEHEZLEETEET,

E#EIZ. AAIZMIDI F—R—RE#FRALTWSBE. ANLEIENYDEHOERFE
BORUEBOABINIVELGGEENHYVFET . COBE. ANLEEFOREZE
[Alt]+[-]/[z] CEETEDLIIZ. BEFNBERLEFFITHEOTWAIENEETT £
D=6 MIDI F—HR—FZ#FERALTAANTIEEE. EFANE (After inputting
note) ISR ETHAMNEFMBLLNFEE A,

—A . MIDlI F—R—KRTIFHKAVE1—4—DF— KR—FZFEALTLSHEE. A D
LIz EMY DB FIBRSNTUOENADL, [AI+H[1][] TEROEEBEISET. X
[CAATEIERDEVFEIRETELIDTENGBENHYET . COAMNERZL
B2 51BA(1F. B ANR (Before inputting note) IZRIRLET,

[ERRRES. TR, 7—Ta4¥aL— 3 %FHBE (Specify accidental, rhythm dot,
and articulations)JI&. EVF&TaL—avDRIIZEET 3HLWLWADARE. T
AL—1 3 EEYFDRICIEET S Dorico TIIHEERDAAAKXD, EboEFERAL
TWSMIZIEBEFRECIREREBET 2 EITSTELTESW, E550DAEBHLTH
T BRI TRLVBRLERLONDELEDEHRLTHSIIEEFTITHLETS,

L—avzEYFDRIIEEIZANFREBEREIZUYEZ HIZIE. [K]
ERIHD. BFHEOAAYV—LRYIRIZHEIEAERDREIVES)vILE
To

IVAAALGDASEYFETaAL—LavDRIIEE: EvFETaL— 3V AAD
BIZIEET DRENEMLHIGE. T IRATEROELFRBELT. TANLBE /IR
TAATBIERDTaAL—230F9)vIT 50 Talb—avnia—bAvhE AR
TEHLETHERERETEET . VIVRANEFERALGVWALNRWNESIE FEIRY—
W (EEFANY—=ILRIIRD—BLDOXEN) A 2IZLET,

ANBREDIEZBEZVVEZ: EvyFETaL—a nmilciEElETa .
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EvFDEE: EVvFETaAL—av ANDRICEET SHRENEMLRIGE. EFD
Talb— a BRI AETHEEFEEMBEITESINFLAN, TaL—3>
FERTHEETFETERFLEMBLIHLRITILEEHYFERE A EVFHIIEETE,
MIDI F—FR—FZ#FERALTLRIEEIE. TaL—2a EZBRORICT R TORBEFIK
LTERELEXTY, BREFMOEYFEIEROEICL>TRREINFET . ERFEIE
MBEHISERT AU, £-3avEa—43—0F—R—KTEYFREHT=IC
ANT BV, BREROBRFEEMBOEYFNEFHINET,

AVELA—3—DF—HR—FEFEALTVSGEEIE. BEE2ZANLTEROEERRS
HTFET, 1 793—T EORLEYFEIRET BHITIE. [Shift]+[Alt] ZHLEASF
FHEANLET, COBEERYRT L, SBIC 1 A 93—T LICBRATEET .1 4
HR—T TEIEET BIZIE. [CtrI]+[Alt] (Windows) F7=IZ [Control] (Mac) Z# L%
PoBELEANLET REERYIRT L, E5IT 1 AUF—TFICBRTEETE
YFETaAL—aVDRICEET S E (When specifying pitch before
duration)1D#A T2 av BT AAL-BERFERFRIKEIZLAEL (Do Not Select Input
Notes)JIZEESNTVDIEE . BROENRIRINTHS [A]+H[1V[I] £FERALT
L. BROEEERTEYFERTEET,

AVE1—3—DF—R—FZFEAL TS EEICEERRESERET HICE. RAIE
Z2EANLTHLEERES DX —HR—Fa—bhvh FIEIRETE [0] (FFaIL).
[-] (FZYR).[=] &v—D) ZEAHALET,

EDER: MIDI F—R—FZEFERALTLSIEE(E. IBOBRE T RN TE—EITHE
WTHBTaLb—avaE&RTHIETMEEANTEE S, AVEL—3—DF—R
—RZEFEALTVSIEEE. [Q] ZHLTHBE—FICAVET, FvLyrOEAIICR
Bhll+1EENRIRINFET, CCTHF—R—F2FALTEELZ 1 DT O2ANTH
EH—VIIEBICEFOENFHLGEMEINET, TaL—avEEYFDRIICA RN
TEHRENDHE LR, THLLICAMN>THEZERL. TRTHEYFEIEELS:
b, MB#TLETETaL—avEm8RLET,

TaL—avmER: ANTHERFIEMBEDOEYFEIEETE L., BYIHRF—
R—Ra—thybEBLTTaL—2avEBIRLET AR BRIV ELRISEIE.
[] #HIH. BRANY—ILRYIZADMAFREFY—ILEI)vILTHE, EIRLT:
Talb—iarDFx—HR—Fa—rAvrEELET,
BCTaL—avBEKGLEEROAN: EXIE 8 N BEREEHRLTANTSIHE.
BEYFEIBELTHS [B] ZBVRLIEFTIELTEETH. Z0HDHYIC [K] ZHL
T.TaLb—2avEEyFORICEE T AR EIT—RHMICRST IELTEET . TS
KUY, TaL—2arv A REICERL TV EEDICEESNE T, BRHDEHRI K-
5. BE K] #LTEYF£TaL—a DRI ET DR EICRLET .
ERFDOAN: TaL—2avEEYFORICIEE T HFRETIE, EFDRYTA—/1—
FHUHTRIICERICERATSE@EEERL TS . Ry TAH—/N—ICA DL THE
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DT LD FLIEFED 1 b THOTEH. TNEERLTERM TSI LT FEoT-
CEREMNGWEFEBLTHIENEETT  BEDHUTILSATS)—IFED
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DA EHLEEFERALZ. KENIRNFEZFZFCHEBMTOERZERALET A,
NoDTOERDEFRMBRERTHEKESATIV—EICERY . ACA—D—DF54
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(F—EDSATZ)—F. LA—FEHIET HI=HIC2KICHEBE L MIDI OV
FO—Z5—DtEyrZEFERAL. SNIER—X Y URIZAZFERLTHNSHMIZE
BREGERAINET . PRAVRAAYFIE R—RARA(FEMYELIEYEERL
YT BILEBYELT A TRAV RS YFIER—RRAYF LYBL VT IV
HEEZIFD B X—R Ay F/—heavbO—S5—(EDMN) H—DHEITH
AFET,
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= #HEE (Init): SOFLWRAYF AT FERTHE. BERBEICEEDO®
BEYNERETEETT, EAESVIRAE OV A—5—D) YO, 4
ED MIDI avrA—5—2 LT EDBRMM THRIAT AL ELFIRETE
FT,. T RTODIIRTL Y 3oy T 2RV FAEE SN TLE
T, IR E TIXINIZZA T, 7RIV RMyF LR, DR vF
DITHRAZDIEEMEF— XAy FEavbO—5—EDMN)H—DH T,

EH: R—ZXXAYFIE. ENENI A= 2D BELREFHEERTEDHLIITHY
FLI=. SEIOV)—RTHR—FENDEHEF/—FREDATIT . FEXD/N—
DAV TIIYR— SN BEHELIT. T— IV RBEERTAIHELES Y EER
TEDHLRIITTEDFETY . BMERNBDEHDHIEL T, THSO Violin SololDITVR
TLwiavIvd OMPBREEZRTHELLI CNICIEBERDOEREEIFFa5
JL (Natural) JIORAvF 2 DETLAH—F (Legato) IDRAAYF 2 DMNEESN., Th
FhD 2 DDRAYFIE, /—bREHTHh (Medium)J&YBLRWNIEFIFE NI L%
EHLLTLET,

J/—FREF.UTD 520560V FT I DEZEVET,

= [#B% (Very short)]: 120 bpm D{FH 16 D EFFF (0.1875 )

= T[4 (Short)]: 120 bpm Dt 8 8 N EFF (0.375 #)

= T (Medium)l: 120 bpm Dffm 4 D EF R (0.75 #)

= & (Long)l: 120 bpm DffE 2 HEFF (1.5 )

= [#E (Verylong)l: ERRKYEVWTaL—30TRT
CO/—rREDFBIRIZEKY, 2ERFRFIVATAIE, REAYD—b, TILA—F L
BRE AESNTVWSIESTEFLREIDYUTILEFHEICHYBZOSN, TIL—XD
ERTETEZFLLIADICTEEY,

RAIFDHEPLEEDL: THRTLYarIvTHADR(vFEHIBRE T ELES

ETEDLIICTHYFELZ, CNIEBEDERREZIIRSHED A EERITT 515

B . BEDTODIIMIRAHAADHD. FEBELTDLYEREDEREENTE

BN TWBDIIRT Ly aveyIa2ERTHIEEIERNTY  [R—RR(YFET

RA>XALyF (Base and Add-on Switches) 1oL 3> D—EM SR vFEERL.
HBIDOTERE (Enabled) IOF Ty IRy REF IIZLET,

RAYF DL RAVFICERTI2BERADEERZOHEAAHLEDELLH|Z
TIEEL RAMFDREBEEF FENDKIIHYEL Iz, ShIZKY, 12ERIERE(C
LT HYTINSATS)—CHERINTWDAEE— BT DRI VFRERETEE
T o INIETR—RRASYFEPEF VAL YF (Base and Add-on Switches) oY
IVD—ENSRAyFERIRLT. IARAT (Name) | T1—ILFERET 5+ TT . B
RALBEERTEIRAVFNLIBTEDIEEDBEBEREIERT 56, VALD
BRIV ARSAVA—EEDELE BERENY—ILFVTICRTEINET,

BENBORE: YUTLSATI—NDHEDEREEEN) T —F 5D —
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@ steinberg

ED MIDI Ayt—YE BEIXELVEFTRESNSGIENEETT, £D=H,
AAYFIZEBT I avDHNELEERTELLIILGYEL -, [IR—RRSYFET
F#4>ZX4vF (Base and Add-on Switches)ItoL 3> DIBERE (Actions)]—
BED77230Nn—IZELMES LIV TRAZOXRMAHY . CNEFERATHERIVTF
DIEBZLZETEFT .

BERBOEE: 772avN\—IZFHLGEBMSNI-TEI{EDEE (Duplicate Action)]
REVED )T BT, TMERE (Actions)|—ENIERZERTESK5(1271Y
sslvf:o

MIZLEVERBED Y IIL—TOBEE: MiILEVERBEDY IL—TIE. BEA
DERBER LT OBER. DFEVFERAF O TILSAT3—TEnoElAaEaHE
HBLEMTEONENEEERT HLDTY . BERDERIEAD 2 DAEWIHEIL
BWEERERINTWSIGE . BEEEZANT VDO EEITEREE BEFUHTEEET
AT LAERINSE, BREBE A [IRYESIhBERRE B BNEIMEhET . Ch
SOERRECENMILTESZE. A IZIE B ABMESh, TORTLyiareyFIlE
A+B DA EHEERESE L EDHENEREINDIENFEINET,

Dorico 3.5 Tl&, MM LGVVERREDHMBDOY IL—TZ2BHICERTEEIN. |
MLBEVERBEDY L -T2 70 SLICEBMICERZIEONIKSITHEYELE,
MERETIE. THVRTL v areyTa el ARICITMIZLGLVEREZED T L
—IhBPMICERINET,

MM LEWVEREEZOMBOY IL—TEERTEEE. [THORTLyareyd

(Expression Maps) JI# A 7RIV DIAILBEWVWEZEEZNDS IL—F (Mutual

Exclusion Groups)ltoiavzREEL. TBE (Auto)IDFVvIRYIREFTIZL

T BIOMIALLBLERREDT IL—T#BEADICTS5E8(E. TBE (Auto)]
DFTIIRVIREBEAVICTHE MIALBLVESEEBEOFEHERLIZT IL—T

([F T RTCHIBRSNFET

BERAMBES: MERBES o, of . K&V ffp E REICHLTHERD
BERBUEEMUH T IENTEET . ENNSATII—ICHBESN TSGR, £
NoDBBESEAD YU TILEN) H—TEFET,

IHRTLwarIyTDHEHAAH: Dorico =& Cubase DITHRTL v 3Ty
TIF. . TTHRFLyLar2yT (Expression Maps)IDEAF7OT(ZT7AIVERSY
JT7URRAYTLTEHRARADDELIITHEYFEL -,

Cubase NDIYRTLvarI v DF#HAHA: Cubase DTHRTLyiarIvI%
—EIERAR—TEDLIITRYELT =, =, Cubase DIVRTL v arIy
ThBIBN—=230 KYLBBRERAVFERARADDELSITHY ., BULBERDE
EHE N9 EFh—b, AFYTEFh—F . N—F=ZHRX aAVYILT1—/It
DITIINTA—/ TFVEUR, TIVB—EUXJEE) ITRIEVT M fTEbhE
T, L. m7 TV —avBTRYUTINSATS)—DREBHENIGYELDS
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f=8. Cubase DITHRTL v arvyvTH#HmIAHAATETE T, Dorico HEDIY
ATy aveyTORFEORIBRIZLSIZBELNERLGEIRETT,

FAVARBLIVTT 45—

Dorico 3.1 TEASNI=FH TR NS/ UHEE OKFER. BRI DTN E=5102,
TEEH) H. Dorico 3.5 TEHITHEILLELIz. FHLL 4 DOITA42—HTHE
(Engrave)]A=a—ITBMEN, REO AU EHEETHRITA XL THBEDOFHL
WAV ETHAUTESKSITHYELT=,

4 DDITAZA—DFERAEIZDOVNTIEEET H1-HIZIX., Dorico DA H#RED T4
AT DONTHO RN TEDLELNHYES . SAVIFLUTOERTHERINET,

» SAUDERKELGZDNFAURTATY . CHIZIE 3 DOBENHYFET .1
DOFX—EDKRSZRHOER. REPER. TLEZER. 2 2HEFERIC
DD TRWMERN SRR, T EHOEADARVMRICHEITT HSVE DS
12,3 DOITIRYBELAIRELGERDEES TEASN DTV TY,

* SAVDFBMELRTHEISEX. AT avTENENIZF vy TERTRTE
FY . FrvTITIIREEL., v BiIniR (GAVR T OBAICEREL
UBHER). THFANER . £ ERESEFERATEET,

» BEICSLT. SAVDHRRMEDER®, SAURTAERICE DD/
IFEDTFAMRTTEEY . FRCETHFRANERF I EXRLSEME
ATEEY,

FAVRT A TAVER (RBREELKRIHEEMADF YT BLUTIURTAHRD
FERELTER). BLUBYIRLATRELGRE S (SAVRTA DB SELTERA) (I
FZNZENFNEDITE2—DHYET, CNODERIETEE (Engrave)l » 54
Y (Lines)IT 1 DITFEEHND=D. T LERBAZRAIBLET,

FAVITARZ— FAVITAI—IEUTOVNT O DA ETHITET,
» REE—FT.S401RILOVTNHIDEIIIVDTERIZHDIT a0
—DRERIVEI)VILET,
» FEEFTEELOSAUEFERLT [Return] Z8LET,
» BEE-RTIAVEZTNIUYILET,
= [#&%& (Engrave)]l » IS4 (Lines) & ZRLET,

IS4 %8RE (Edit Lines) 1A 7RI DBRTREINET,

Dorico 3.5 N\—av B 27 R—T Steinberg Media Technologies GmbH



Edit Lines

lame:  Solid line with solid arrowhead

Center Annotation  Hyphenated Text

Cancel 0K

4705 OERITIE, £FFTKE (Horizontal) INTEE (Vertica) IEBELDSAY
ERETINERTEET . BET DMV FRIRT 5D FIEVRAMD—BTIZH
B792avN—DREVEFERLT, Fo=<HLLSAUFLFRERIRDDS >
ER—RETDHLWSAVEERLET . A A7 DAEBID/NARILIE, KERER
ELTW OGS LEERZHBEL TV SBEETRRRVELGYES . EEREZHEEL
TWAEAE. RA7 LONBEERLOTVELSIC, TLEA—IZF147RT DOEAC
ftAEICRTINET,

NRIWERDA T IV TIZRYET,

= RF4REAIL (Body style): ZDELH5—IZILI%E (Engrave)l » 151>
RT 4 (Line Bodies)ITERINT=TFAVHRTADBURNTYTEINET, ZD
TIZIE SAVRTAZEREFT(TERTESI 51K T« (Line Bodies)1¥
ATATIZOY TR IDHYET,

= BAREIEDF vy (Start cap) D ¥+v7 (End cap): COELYE—IC
(X. %2 (Engrave)] » IS4 ER (Line Annotations) I TE&EzSNT=, F
YT ELTHERATESSAVERNT R TIRNTYTENET,

» EEHODOFXvyT (Continuation cap): CHOSAVERIE. SAVDRIDE
FAh (TBRYBEIB DX vy (Start cap) INMEASNET) LISt D LS Ak
OB EICHERASINE T, CNESIUBMHBERYYEF O THRAEEI(C
FERIN. KERICOAFBEREINET , COF vy T HNEDLSICRTESNED
TLEA—THRITZBEIE. TLELA—DTIZHAIREYEFCHETERR
(Show Crossing Break)]Z74IZL TSN, SAUM 2 DDET AU
PINTRIRSINET,

» ERHRIEDOF YT (Continuation end cap): COSAERIE. SAVD
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REOET AU (RiFDFvT (End cap)lhERASINET) LSt DES A
rOBRTHEBIZERINET . CNIESA U EERUIYEF O THRAUESE
[CERIN. KERIZOABERAINET . TOTICE. EFREREF(TIERK
TEBISAUER (Line Annotations)IZF A 7RI IZO YT 5090 HY
F9,

» BEREHMSOIEEE (Distance from staff line): SAUMNERDIMAIZERES
NTWBIHE. —BNADOERRESIDOMICHFIN IR/ EREZERL
FT.DENFRESNTVEVZE . ADYICEHEEFT T aonlS1Y
(Lines) IDR—U DIERNLSLDT 74 ILEDEERE (Default distance from
staff) JIDEMIFERASINET,

= FATLDSDIERE (Distance from item): Z7ATLMNERDIMAIETERE
HTWBAIEE. TDTATLESAVDEICHFSN o/ EMEERLET,
REMNSDIEE (Distance from staff line) TP AT LD D I Bk
(Distance from item)l(&. BEIZKELTEOREVANEIZERAINET,
COENFESNTLVEWNEE . hDOYIZEHEEAF T3> DISALY (Lines) 1D
R=ODMNEIABETATLILORK/NERE (Minimum distance from
protruding items) IDENMERINET,

= DYV FAURTAERL/9—2% R (Hooks follow line pattern): L
TNODF YT (CTvIFEIFRIGROERAINEESINTNSSAUTIE. C
DATLaAvEAUNITTIE, TV FERIFERHRICSTAORTALERLS A2/
A= EETHNIEERAINET . TDD. 2ERAIESAURTAIZRIR
NMEAINDHZERL. RLBREEVEBAREICH S/ - ERSN
BIEE . IvIERFIRIFERIE. SAODIE—2ENOLNZEITORSHH
BRY. SAVRTAERLRFMILTHEMET . REN+ATEELMEE. T
VI FEIERIRRIE TSI FRICERBSIN S TE=FERALTHEMIMET,
RRFLIEBBED NIV (TR EGDENERHDIHE . TV IF- LR IR
ERAD—FDEDAHERLTHINET,

» HEBRZLITRTA 2% R (Whole body on each system): ZDA T3>
(F. AP 1 DFELIFBEBOMERVIVEF-CEHEE. F12DET AR
LIZSAVRTARBERERTT DD, BT AV RDBIHWSAORT1EHE|
RETIDRELET . DB —FI NPT UVDIEUVRTAEFERTS
BETY, BRI EITRT 1+ 26% KRR (Whole body on each system) 1%
AUICTBHE BT AN BARL, FERDSHLDIUR AN
RERSNFET . ATICTDE FETAVMMIIEVE DI DHRRESN
F9, BRI, SAVICTHhREEDZIR (Center Annotation) FE =X/ o
TUFZEDOTF AL (Hyphenated Text)IAMERAINTWNSIEE. #BRILIC
RT1£&HERT (Whole body on each system) JIZ&> TEREHEIN R+
GAVNTRYBREINED ., E BT AVMIHBEISNEONRESNET,

IRRILDBEBIOFTLavIENER (Annotation) IORIRKWABIZGCTEIELET . =
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NIESAUNIZEBITFEREEMT HEIFERLET,

[PREBEOIR (Center Annotation)1Z:ERT 5L, THFAMELITEERLEBICEL
HERNSAVDHRRABIZRTIINET , CHICIEUTOFA T av N ERATESE

ER

ZER (Annotation): COELIE—IZIF. FREEBDFRICFEHRATELTAT
DIAFRNIRNTYTENET, Dorico DTIFHFEFEDSATS)—IZ(E
THXRNFELIEBFREEBICKESAVERMNFELLL O, MEIRE T,
FIRERSNE=TOD OO ZORIEABEVAREERYE T, BUHRSAY
ER#ETSE (Engrave)] » ISR (Line Annotations) | THERRT B &,
CCITRTENDEIIHBYET,

E|EAIE (Vertical position): COELIEA—(FSAVERDSAIUIZRT S
MEZEETAHLDT, FAVITHRFA. /D EFLETHOEEZTE
RTEFET,

fBYIEL (Repeat): FREFAVDOHRRICIEZITRERT DD, F1VDREIC
Ol TEHERY BT MEETEET . FTROBRYBRLEERL-GE. —
EBRETRY RS H (T%EEE (Equidistant)]). S/ O RIAAE TIXRERE
RELMTHRETIENETSH (TNZE (Accelerating)l). HEIZS5A > D
SRAIEB TIXRIFRE /NS R THRIB TIERELT 50 (TRHE (Decelerating)l)
HEECTEEY . [FHEM (Equidistant) 1Z:ERL-5E . TRYIEL O E#
(Repeat distance) ] TEFRE YR HIfRERAR—RBEATIHEETEET,

BSE (Placement): FREZA> DIhR (Center)lIZFRRT Hh (FIHEKE).
TBAsR (Start)JF/IEXTRT (End)IDMEICKRRT HMEETEET . TRE
FAVDFRNBEFE IR THEICRRTLTWAIGE  ERIZTRB/ETO
[Ef@ (Start/end gap) DEIZHELY. tatnE = (TR ImMSRBICEBLES,
[BASR/#& T OREIRE (Start/end gap) At 0 IZERESH. SA> DXy T THIA
FEIERTLTWAEE. FRESIO LOZRLTIMED X vy T4 LESE
LTLESZEITERL TR,

HITKTE (Always horizontal): AU ZEIERSE-EEC, FAVFRL R
[CEIERSEHNEINERELFET .

[INATfHEDTH AR (Hyphenated Text)1&:&IRTHE SAVERICHI->TE
I CTRYILbN-BEEPTL—X ([slen-tan-do-po-co-a-po-col % E) MEBREINET,
CINICEUTOA T av M ERATEEY .

i (Syllables): SAVDERICHh=>2TRRIHDTFAMNEZIICAALE
T BHCEICNATUTREBEIIZL TS,

TAURREA IV (Font style): WA ITAFEDTFRAMIAERT 574+ RE2A
W% THZE (Engrave)] » I+ FREA)L (Font Styles) I TEZEINTLY
LERMSEELEY,

TXALTHALE (Starts with text): ChEAVITT 5, TBRBEIEDF vy
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(Start cap)JIZAIDFREINTLNESEDL, ZOIDYICRIDEEHNZA D
BB EICRIREINFET . AT 5L RPUDEH IS DRIBMEMNS
DUBENT- M BICRTEINET,
= FXRMTHRT (Ends with text): ThEAvIZT5E. EEEDX vy (End
cap)ITAIMERESNTNEI &L REDTEH NIV DRIGICRTEINE
T AT HE REDEHEISIODKRImEMASDLEN-MEIZR TSN
F9,
= ZAIDORER (Gap on the left)/AfIDRER (Gap on the right): Zhi-MDfE
. SAVRTAEBMBDEHEDRBICENLETOEBREZRTMEELET .
= {IE (Position): A AR TAIZH T 5T FRAMNDEEMEFIEELET
FAT7ATERDSADIACDTIZHEZT I avN—DET7(aY (B) &0)v0
FTHENEELDAVESEERTEIFR IO VMDD T IAILNELTRETEE
T, TISEHAFREICESENEISA A1 TERELE-EZTHNEKEBICRT B A (X,
BR7/4> (B) 209 ILFET,

FAVRTAITT 15— [%E (Engrave)] » 51421 T 1 (Line Bodies) 1%:&RL
T IAVRTAITA43—EREET,

Edit Line Bodies

Category:

Name: Wavy body (wide- )
Repeatable Symbols RO CEN IO

Wavy body
Wavy body (narrow-wide)
Wavy body (variable)

Wiggly body

Wiggly body (fast-slow) \_/ \/
Wiggly body (slow-fast)

Wiggly body (variable) Show repeat point
Wiggly body (wide)

Repetition:  Individual symbols ~ @ When line crosses system break, add ends to each segment

Add tostart Add to middle Add to end Show repeat point

Cancel

kX EAOTHTIY— (Category) | DELYE—EHERAT DL, THALTHI/VRT
1% 3TBEMNLBIRTEEY . TNENIRIZGRBALTNEFT,

[—#% (Generic)ITlE. LTFDATLavARATEET,

= RBAL)L (Style): 1 KROEHRERTT HIER (Solid)l. 2 KO FITLERE
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KT BHIZER (Double line)l. Ff=XE BG4/ \F— THR M R IRE
KT DR EIL AR (Dashed or dotted) IDS>L., EDRELILETA
[CERATAIMEELET,

= ROKE (Line width): BROKSEAR—RBATIRELET

» R LRIRD /58— (Dash-gap pattern): SAVIZFERAT G EIER
REBRD/INF—2 AT DEDRTELEICSCTEBFERALTEELE
T, CCTIREIENARTELG>TWIRELAHYET ., 1 DHODEIXHRD
RIFLIEIRADERERHL. 2 DODEFROBHREIEIRLDOMERER
bLET ., FNFNDEXBEDOESEIOO0VTRYZBENHYET . RSE
TE (12 © 134 73E) TH FE/NHRE (0.5 © 1.75 2L) THHRETE
FT, COETHBRORIFIEETHLEIFTSRADEEFERAL. ROERZE
BETDHEEEIAFTRDELEFERALET , 12E2I1ET1/2; 1/2; -1/2; 1/21&005
EXEIEET HE BIREABN 12 AR—ADERB TR EIZRTINET,

= SAVETDER (Line separation): TR4AJL (Style) IAT=E#R (Double
line)JICERESNTLDIEE. F179 5 2 KOBRDOMERERAR—REN TH
ELFET,

[#&Y:ELFIE4 588 (Repeatable Symbols) i, D ERTE LIFHOELYET, /8
FILEEDTLEA—IZIF, UTOSFEISFLREEFHAADOEERLARTINE
ER

ZDTICIE. SAVRTAZERT DI=HICERASNDEEE 1 TTRRTDHTUVR
DPHYET, FAVNHFEDE S CHIBFERIIR T ITH5E6F. MBMEDRSTICIE
SI.BRTHEDRESICIXTEIDFRNGEET, BYRLOGEEZRT (Show
Repeat Point)1Z74 23 5E, ET7ATLIZRDIESDHEN AT AMEERT
EEB{NRTINETS, JVIEDLRESZHIBRT AICIF. BB ETERLTT VY ay
N—DERIZHIEIRTAED )T DM, TVIRTREEZT TILIIVILET,

J)IRICRREBEHLGEMTBICIE. TOTOEBITOTVYREFERALET  EHIT
DOTVIRRDEBESTILY) v 5L, BB IFIEERBTLELTLEDS Y YRIZEM
N FAVRTADEZITTHERTEINDKSITHRYET BB ES1U R T DRI
BEITEMY BI2(F, EEFZRIRL CIHMRAIEITEM (Add to Start) 120Uy LET,
FHRIC. BBESAVRTADRIFIZEMT HICIE. BEEERLTIREEIZEM
(Add to End)1Z Vv ILET . EBHTOTYYRIZRREINIETIE. EHE
(Engrave)] » T#&YiRLTTHE/REC S (Repeatable Symbols)ITERINET . Ch
[CDWTIXLABE TEHREALET

RE&IZ. 2 2DTV)RDOREIZHAT#YIRL (Repetition)IDELIE—TIE. S/ D
ERICh->TREZRYRIEDAEEIRETEET,

= @BAIDEES (Individual symbols): S/ DERENZENEFNDEEEDEEIC
FOTHEIRINFET, ERIXTAURTAITERED 3 DERESNTLDIIEES.
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FAVRTAE=ZREILIz 1 DHODEFIZ L DHDEES. 2 DHDFEEIZ 2 D
HDEE. 3 DHDFEEIZ 3 DHDEEN. TNENDEEHRNTRY RS
79,

= NNA—2Z{K (Whole pattern): SAVDERITHTz>T. FEESZIESHIC 1
BEF2RFT /- RYRESNET,

[SAUNRMBERUVETCLEE, BT AVMIE T /AF—2%EMN (When line
crosses system break, add ends to each segment)ll&. SA/>DEET A%
HHRG R ZHF ORES CHIBE LU T IEIMNEINEIRELET,

[{SURTs (Wedge)ITlE. UTOATLav N FIATEET,

= (EUDAAT (Wedge type): FERTEEURTORKEEELET [
1BARDASMEI (Flat outside)ll, SAUHERD LICRBINHEFE
VD LEBNESIZ, ERO FICRESNGSIETANESICRYFET [T
187D A4 (Flat inside) J1E. ZD&EIZ4HYET, [3FF (Symmetrical)J 1.
ZD—BRXNMIENo—FEHIMIBEF T, L TFHAHFELGBRIZGEYET,
= BARRBIEDAXE (Start thickness): KSUWRTADEIHRD AKSIERAR—R {1
THELEY,
» RTHEBEOASE (End thickness): <SURTADHEIFDRKEIERAR—RBifL
THEELET,
FAVERIT 43— SAVERIT43—%FICIE, T78#8 (Engrave)l » 504>
AR (Line Annotations)1Z&:ERLET .

ward-pointing axis-aligned hook

Right

Left
Len,
ine w —

Up-pointing rotatable hook

Cancel [+]

ELADIATIY— (Category)IDELVA—%ERATHE. COFA(T7AT TERT
EOTMVERDEIFEFLRATERIRTEET . TN NIBICHRALTLEET,
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[REN%d (Arrowhead) I TlE. U T DA T av A FIATEET,

EXEIDRAAAI (Arrow style): XEID kixzE 2 AR (T
(Chevron)l). BkZE (T=A (B) (Empty triangle)]). ZYD 5L (=4 (B)
(Filled triangle)l) hoWLVFNAEELET .

18 (Width): KEIDIEE AR—RBEHITIRELET

=< (Height): REIDBEIERR—RBATHEELET,

WOKE (Line width): REDDEIHEEIMDOARSEAR—RBEM THEELFE
ED

299 (Hook)ITIE. U T DA T avnFIRATEET,

& (Length): KEIDRSZAR—REMTHEELF Y,

BOKE (Line width): IZVIIERTHMORIERAR—RBEHATHEELE
j—o

7 [ (Direction): ZvIDRKAMERELE T, 7vIEKFERTHERT S5
B.BRLFEVOTVREL. EROLTELLICRESN TV TLERDAR
ZRKIAA (Inward)1&. ERERFT DA RZERLISME (Outward) 1 TY A
TyvohNEIZTE (Up)1EEIETT (Down) 1ZREKESICHTEET . IV E
ERTHEATIEES. BMFERATELDIENE (Right)1&ME (Left) IOA T
HBIETTT,

[l &5 (Rotation): 7y I MNSAVDAEIZAHLETCHET S (THEE
(Rotated)]) M. BICETFTEREOLWThAhDFREZEREL (T#ICHZ S
(Aligned with axis)]) N™MEELET,

[EF#FE (Music Symbol)ITIE. UTFTOATLavhFATEET,

05 (Symbol): T#REE (Edit)1&V)v T 5EEBITA3—MBEET, 2
TIEIAUAD 1 DUEDT)IEERLEZY ., T RAMEEMLEEY, 7574
YIEFRPAATEYTEET, BEEHRELTHBIOKIZEV)YILTERELT
13—%EFLBE BIRLIZEBENNRIILETBOTLE 2 —IZRTEINET,
KEFRDTRAYFAUMIE (Horizontal attachment): EERIZx T35
BDTAVFAUMIBEEELET .

BEEARDTHYFAVMIE (Vertical attachment): KEIZxT SRS
DT BIFAUMIBERELET

L DORIFE (Gap above)/ TORIFE (Gap below)/ZfIDMME (Gap on the
left)/AEIDREM (Gap on the right): BB ESAURTADREIRERAR—RE
MTHEELEY.

Bl 85 (Rotation): BEASAVDOABEICEHLECHET S ((HE
(Rotated)]) M, BICETFTEREOLWT LD ARAZERL (T#HICHKIZ S
(Aligned with axis)]) MEELET .

M&In#R (Terminal Line)ITIE. U TFTDA T3V FIATEET,
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£ (Length): BIGIRDRIZAR—RBEHMTHEELET,

DK (Line width): #BIGIRICERT DMOKRSEAR—RBEMTHEELE
ED

A 5 (Rotation): RIGFMMNSAUOAEIZEHLE CHET S (THE
(Rotated) ) M. BIZETEREOWLWIThAADAMERL (THWICHIZ S
(Aligned with axis)]) M™MEELET

[Tk (Text)] Tlk. LTFOATLar AFIBTEES,

TXRbE (Text): FAVICRTTIEBOTHFRACEIEELET .
TAURREA)L (Font style): TXANMIMERAT DIV MREAIIWNETHE
(Engrave)] » 7+ b RA2A )L (Font Styles) ITEZIN TSI MBIEE
LEY,

KEFHDTEYFAVMIE (Horizontal attachment): EEICHT 3T
FREDTAYFAUMIBHFIRELET,

FEEHRDT7EYFAUMIE (Vertical attachment): KELRIZH T BTFR
FDT7RYFAUMIEEEELET

L DORIFE (Gap above)/ TORIFE (Gap below)/ZfIDMME (Gap on the
left)/ERIDEME (Gap on the right): TF¥RAMESAURT A DREIfREEAR—
ABEMTIEELEY,

B85 (Rotation): THFRAMMNSAUDAEICEHLETCEHRET S (THE
(Rotated)]) M. BICETFTEREOVWT LD ARZERL (T#ICHKiZ S
(Aligned with axis)]) N™MEELET,

ER2EEYD AL (Erase background): TXRNEFEDEEHEEET HME
INERELET . FAVERRRNTHEATIEESIIINEA VICTHE GE
BREDEFEDTHFACDRABE TS EINET,

AU RARN)yHZEELRR (Ignore font metrics): E FADEEHLEHEEZH
=74 b DBEDAN)VIEZERE T LYERBLE-EARICH>TTHFRE
ZEEEYTHIIEELES . [TEREZEYDSL (Erase background) Iz
[T TWBIHEAIE. BYUDSRLDH A RIZHEELET,

[#YiE L aTBELFES (Repeatable symbols) I TT448—: 47 0J #BKICIE. T
£ (Engrave)] P M#&YRL AT 8EAEE S (Repeatable Symbols)1Z&:&RLET,
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Edit Repeatable Symbols

Name: Group glissando 1

QOO0

: Composite: ~ Edit...
Constant circular motion segment (large)

Glissando wiggle segment
Repeat offset: 1.22

Cancel

CNEFERT DL SAIVRTAIERATEL B DRYBRLAIRRGR S ERETEE
T AT aAVITEUTRHYET .

= EE& (Symbol): THRE (Edit)1Z 0 vI T HERBITAH—DBEFET 22
TIEIFUEDE 1 DUEDT)IERBIRLIZY, THRAMEBMLIZY., 574
VD EFTRAAATZYTEFET BB EHRELTHBIOKIZI)YILTRELT
13—%FHCAE BIRLEEENNRILEEBDTLE 2a—IZRFREINET,

= #BYIBLDOZ Ttk (Repeat offset): ik SR ELMBET HHIEBICHDEE
BOEHMNODEMEAR—RBATIEELE T EX 0 [TTHL. EBBEDE
HOSIXWETRDEBELN A —N\—FvTLET,

IR EEDTLE 2—ICIX, BB L@ OHRITONELSIZT H=HDY—ILH
LOMAESNTUWET , [EHERT (Show Multiple)ll. BB DX REEHE
BYIRLET, BYRITESDBME XH#YRLOAT7EYE (Repeat offset) 1D
BEICHVETS,

[BYsELDREZ R (Show Repeat Point)]lE. M#YRLDA Tt YE (Repeat
offset) INJREMEBIZA LV CEBDEERERTLET .
REFDESHIUDIEEELED IS DEMNEINEHERT HIZIE. [HE (Engrave)l
» IS4/ T (Line Bodies) 12 AL T, $FEEDBRYRLARELE EEEATS
FAURTAZERBLET,

HF{+E{EF (Figured bass)

HFAEES(E. 17 =g, 18 HEZICHFTI—A v/ \TREEIC—EMICERSH
EEEODEBRETY . HFEEEDOELTHN—E=Z—ZRADHIZERASH
FT. ENTNDOBFL, BESNTVWSEFLOFEREEZRDLET,
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e OO t K— K t K— K T ¥

)= : " I X 1 i — Al I i — I i K
& - j j T . .
#6 8 7 7 6 4 6 #4 6
5 H H 4 2 2

HFAAESEZTEIRE. BBECILINIEDOHRERTERSN, FFHBEICESTE
BERYTHAN—FE—EHENIEGRADIENTE BREICLOTIIAEERZRELT
HFDOFERIHBYDREMGRIEEZ TNEHLDTT,

Dorico 3.5 Tl H#FHEEFTANADOHLVRY T —N—NBASh, R37(
RNT DI=ODFMEA T av BT BFTNETNDERBRDEREER S HE
MoFon-mBEOKEbIRMASNTLET,

HFHEIEFICKT S Dorico D7 TA—FIE, 2 DDIF-ZTYRLGD2ATDERE
(ST HEEZBRLTVET . 1 DX HFAECICEDIIITRTSNENEA
NEFICIEFEICIEE TEHHEEICKY . BFEDIRDERGBREAIRRET HETT B
D120 HEDERICHLTEIYVAUTIDIUMIR G TESBHRER-E. 8L
TavEFERLTHFOERMLERRAEEIRET DEHDT T av &R 5.
RELGTIO—FEERRTHETT,

NIEMEMIZIE, BEFANDITaL—30%58H (Force Duration) 1¥gED A~
EXDEGYBZDZEIZBTWET , ITab—a %#El (Force Duration)1%&4
VISTBE. TNTNDOBER. NB. BLURKRFTEEDKSITEET I ERICIEET
FFETEL AOERFIIEEOBACHIRGE | FEOBEICKELELEN
HoBmE. CNERMT H-DICHATIEENESESNLED BHEIEA
YEF, ChEEHBRMIZ, TaL—2a>DiEHEFIIZT DL 2MIZEEBHFON
BEIOARFOT I —TIEGE B LDEELGERICTONT, iREA T avIckbiE
ENPEPLTLGEYET , TNICKYEHEE LY TRICA N TESLE (T TEL FHLLVE
EICEHOE THRICREZESEEI LMD, FEMNICREDEBEICKELLEES
MRABEDEHELNEFEYET,

L= o TIORBRIE, TOC I MOBFRRICITESICENBOHTEETY,

AN T ay: RVBEERANA T av(E, TR (Write)] » TERFADA T3>
(Note Input Options) I DI F E{EHF (Figured Bass) IOR—TIZHYET . BiF
DIREEEICERTI2BELNHDIGEE . FEHFAHEEFTORFRICOVTHEM
CEHLYDRHBHEEIE. TRyTH—/—h oD A (When inputting via the
popover)1ZI ANRBIZFDFEEH-S (Follow input literally)IIZHRELET . —A.
HFORTAZIIODVDTOFREN IR R TIE-TYLAWNMEE, FETO2 I
DEITICONTEEEZKIBICER T HIENTRISNII5EE. HEATaVIZ]
5 (Follow Engraving Options)JZ:&RLEY,

AT AV ERFHREEBEOANBINRELIHYET . COFTLaVEEELT
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3. TACIIMIT TIZAAIN TO SR FHEEFICOVTRIEEHYFE A, 1=
EL. RZEICELTENCBRFEORFHEEFTD) LY TEEY IO TIE,
LI TEREALE T

HFEREEEORYTH—N\— BFFEEEEANTBIZF. ANERA
BT DMEDERICF YL IPERTSETHL, FEZTDERDERE ﬂ
BIRLTH L. [Shift]+[C] ZAN., FLFEEE—FDV1FOERIZH
BECEY— IRV IRADREVED )V ILET . FrLvbFEEILERPOLEIZKRY
TH—N—DRFTEN, HFEANTESLIIARYFT,

= Ry T == F 1AL FTHOHFEEALZIEBE CANTEET . H
FIIEHBNICRIBCHEVEZSNET,

» RS EIEETAEE. V—TIZF#1E. 75 yMZEIblZE. FFa35)L
[CIEMIZAALET . BEESHABEAINIDIEZTOROHFTLEEOHT
DELLIZHEM ., BEILFROBFEOBRICE>THEINET A, EBE
SEKTWELHDEE L. BRSSO FLHYESHTFIL6,#4,2]
DEIZAVITRYI>TAATEET,

= EELTO3IEX THIFHFTEANTEET,

= Dorico TIXFAALEZUSNDEHFHLHERSIND2O. —RUEHFTHNIL.
HFE 1 DM 2 DLHAALEKTE IRIF TV AHFHAEBMICEDONE
T, 1=E2E FE 1ERIDOMNSATE 3 EL 6 E) #AHNTEEEIE. T61EA
ALFET,

» BFEOMFEERRELTIEETSICIE. FOMFELILENCTEAET, =&
ZIEM6<3>1(F. T61F KR RLTIB3IZIERTRICT HIERELGYET,

» ARV DRERERET HIEE . 2EAET4->31EA DT HE. Il 4
En 3 E~NOERERLET,

F1z [Shift]+[Q] DRYTA—N—THEATLIDLRALANEX T, O—FETEAS
FTHIELTEET . DFEYIEMTIOIGBIHREEANTDHE LD I—FEES EE
PR FIZEBRINET,

RYTFH—N—ZEIZEDD: BFAFEEFTORY T —N\—FUTOF—THEDHL
nEy,

* [Space] [&. ROBEMNRDEFDS>E. KICHAIAITEAET,

» [<V[-=] [ BIDNRDYUX LT YR EIZEARET,

» [Tab] Ff=[& [Shift]+[Tab] [&. BIANRD/NEAD IR EICEAET
BFAEEEORRMEDIEE: Dorico TIL, [Shift]+[G] TRYTA—/I—&RUY
HLUIIGEE. EDAV RN AVRTCH > THIHFHAEEELNRTINET , I5I2H
FREEBEDRTRINDAVARYILANERIRT BIZE LATIMEToa>nl T
L—Xx— (Players) IO R—ZH LGEMSN T HFHHEETF (Figured Bass)lt
9 a DI FEFEEEERTT HFL—V— (Players to show figured bass) 174

38 R—=Y Steinberg Media Technologies GmbH



Dorico 3.5 N\—C 3V ERE

@ steinberg

TLavEFERALET . COICF BFAEEENEROT WHRE) FELDE
Lo[IRRNESNENERET HF T avtHYET,

A—AILEHFAHEES: DHERETE. HFAEEFIETO—N\ILITEESA T
FT.DFY. FUoHUTILDTRTDAV AR IILAVMIEILHENERSNSER
BINET, BLEDIAIVRMYILAVMNIFRLGIHFERTTILENHDIHFEE. A
—HIVEHFAEEBFEERLET . Ry TAH—/—D BN TS EE(C [Alt] 28T
EERTAHFOREANENBIRBDA VALY IILAV DA B L5 — BRI
ESNFET, O—HIVEHFREEZTZERLTANTBEEIE, [Alt]+[L] Z#HT &
Ry TH—nN—mO—hILABE—RICEESN. [Alt]+[G] Z]TEIO—/N)LAA
E—RIZRYZET,

HFFEFIIHTIERE: HFEFESEEEANT DL RYTA—N—DHEIZH
HEENEHERELELLT. AILEHRFICHETIEFOENEYFATEIN,
REINFT . ZOH. BEDEVFEEEL-GES. HFEFBHEDR. £EEN
FYEAFEBEEEZREBLCERRBEERLZIGE. HILWVEEBE RRT ST
BENEZTMAONF T CNIEFE. BRDAURMYILAVMNIT O—NIVIGHFE
RNTDRET. TNTNICERLGLHEFERELIZEE. TN TNICELGDIBFLE
RENBIELEEKRLET,

HEMESETORH: RFASEENEENEEEZRHT LI5S, EFE—HEICH
FhHHASh BEISECTOYy—TANTSVMIBEEBZAONTY, TV v—T
[CESHALN-YLET,

R—ILRESA2: BEHNEIEL. LOALZN U DOIEDER B IREFSINDIGEE. #
FOEANEHRITIEDT L—aviZhz>T, HFENMSBUSE—ILESAMN
EHOINET . R—ILRSAUFBMT BI(E. iFEERL T [Shift]+[Alt]+[—] ZiF
FTER—ILESAURRTREINET, [Shift|+HAI]+H[—] ZBEERTEREDY X LS
YREIZHNR—ILESAUNBU, LWV RILESYILTRSY S 3 5E. R—IL
RS/ oxmBIXLI-YRLIZYTEET,

F=&, TANTFANRRILDOTEFEMAEFIES (Figured Bass)1J IL—FIZHABITaL
—33> (Duration)JDTO/NTFAZAUICLET . ZCOTENRTATIE, R—ILRSAY
DRESETaAL—2aVTHRETEET . EAIDIER 4 D ERICEAIEETY . HHID
ETEH. BEICELTHR—ILF AN EMEROME TR T IS LEHEETEEY .
AR 12EAFT4->31EANT BHEELTHRRULIVERET HE. iR
BOHFIEHRAR AV CHRIZERSNET  MEZHAETHICE. LY )a—
AVDEFICRRINDIADNCRILED)YILTESYT 50 LY )a—>
avDHIE (Resolution pos.) IDTANTF4EAVIZLTHBEZIEE TEEY,

BFDER: BEF T a0 DI HFAFEEEF (Figured Bass) | DR—IZH LT EF
(Figures)J o avIzlE. BFO—RMGHAEHLETRTIZTOVTED LS
B AINEHRET AT avhhbYET, 2EXIEIL—ROI IV PEERONSA
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TROEELFD 3 EONBRGENHYET . ChoDFToavE EFRANFTTY
v DIRYTFA—1—hoD A HEE (When inputting via the popover) 1D §EEH4
FLavIZiES (Follow Engraving Options)l[CERESNTWSIGEITERINET,
— A TJADRBIZFDFEESES (Follow input literally) JIZRELTHFEEZA AL
BE. ANLEBFENZTOFFEERICHBRINET,

BERE HEIBEENTNIVENEEORFFIFEETLHBREOBRIZHIES.
HFERTTIDELHDINEIMNIDVNTIL, SESFLRDRANHYET . =&
ZIECACY—DF—TIEE B EEBLITD 3 ENHIIEE. ZLDIFE 5 EIZE
BRHESHFNEZIONERA GHMIICIE. ZORBROFTETILRE 5 ENREIZYT
WHDTH-1F-0. BELOBEROBERICESANELSIC. 5 EF T LEIFonE
ED

CDESHERREEDESICESINICOVTIX, BEXF T av DI RFEMHFEES
(Figured Bass)IDR—T(2H AT #F (Figures) 1o arvDIBERDIGSIEE
[FFRIFEh=-#F%EIERT (Hide raised or lowered figures if they form a
diminished interval) IOZ 7L 3 EERALGEIRTEET,

BRI, BERANT T a0 OIEFHEET (Figured Bass) | DR—2IZH AT BF
HEEZAHBEOREEOMBIR (Interpretation of decreased intervals during
figured bass input)IOA T3 EFERALT. Ry TH—N—moHFHEEIEA
NI BRI EREHBT LA EEEBETEES,

HUIZEILFES: Dorico ITIE. HFHEEZTORUEILESZELL. MFITHUER
FFEESZEFMITEMLT. BRETRED-OICEBERITRYRERELHYFET,
COMEEZEMIZTBICIX, FEF T ar DI HFEAFEEE (Figured Bass)JDAR
—DIZhBHIEEES (Accidentals) 193> DI B EILEFES (Cautionary
alterations) % . TBIC/MIIZEIR (Show in same bar) 1E=IZTEIC/MEIERD M
Hi[Z% 7R (Show in same and following bar)IIZSRELE YT,

HFEHAEEFTD YL RyTA—N—DoHFHEERBEEZANTIRICTAIAE
IZZEDFEFEHS (Follow input literally) 14T a>E#FRALI-ED D, &RIZHE>TH
FRHEEFICETIEEFTIVEEE L. CNISIELTEHT 5161270
CIUMNDBEFEOHFO—EERFITRTE) VNS IBENHSZEIEL. 1 DU
EO#HFORAYHERIRLTHSMERE (Edit)] P THFFHEES (Figured Bass)|
> I FFEEEE) Yk (Reset Figured Bass)1&RiRT 5L ybTEET,
CNEFEDEREILTRE (Edit)) » TRFHEEF (Figured Bass)] > TREDISMER
%58l (Force Current Appearance)l T, TAIRABIZEFDFEERD (Follow input
literally) 124 VIZLTAAL-GE LR EBRUL-BFONBRZEET 20 REH
LFT, I BOOHFAESEEDREA T avZ2EELTE. ChoD#FIE
BHSNLGNIEEEKRLET,

HFHMEEZTONE: FEF T aoDIHFMAEEF (Figured Bass)IDR—I|Z
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HAHIEGEREE (Accidentals) IDEIL a3V T FELTFEIUVEETTIFOHFTE
RY O BHREERATY AREORFOLELELEFATIMNERTEET,
[TH4A> (Design) |27 avICFELIT, FELEIFD 5 ESLU 6 EORFOINE
FHMICEIRT2-HDF T ar O HFONBIEHMNERFNIEEDTFRL
TAVRDELLEFERTANERIRT B-ODF T aGENHYFET,

B 57+ e EAT 556 . THFAFEFTOIER (Figured bass appearance)]
#IFL—2742F (Plain font)JICERELTCIHFEMESEFTOIL—2T4200
(Figured bass plain font)1ZfER9 52 &&ERL. & (Engrave)l » 242k
ABA )L (Font Styles) I CCnEFwET Hh ., £=ILIKF (Bold font) JZRRLTH
. [§#& (Engrave)] » IEEEES (Music Symbols) IO #FHEES (Figured
bass)1ATI)—T. ERATAELRDEERESTEHRELET . TL—I4 0 OFEA
#ZERTHBE. EFLITFELZEFTTIFORFEDIE (Appearance of raised
or lowered figures) (I g TEICERRFERE %R (Always use accidentals)llZ
HELTLWABELHYET , ChE. BEDTHFRANIAUMIEHEELIFERT I
OITBHBEGACOA—IFHFZDHFNEENTLLELHTY,

EBICR—IFFAVB LU AR IVICET A ToavE RSN, ThICER
—ILNSAVERFTEIZ L ATIRHGLKEFD 1 b TEI2 1 ARTEEDHLOP,
D1IADIAVDEEMBERENHYFET

Dorico Tl&. HAEDIEEAKICHI->THFHETEEORELBEHH—=0 T HEST
SN INFEA VA XDNKTE BFLERIFRTOHAEHENHIFETES L
ST BERFOTEZIMICTRABLET . EBRESEHFOR. BLUHFOITHOD
TIAIEDERMICEAT AT avid, FEA T a0 OIHFHEESE (Figured
bass)IDR—L DOIEESIE (Vertical Positioning) 1o avIchYEd,

FEEN HFET TR [AL] ZHLENORNF—Z2FEATHIET. HFDID
NEBEZWARTEES . R—ILFSAUDARTENHF DI DUEEZ MRS L5
BR—ILRSAVIEHFLLLIZBEL, BISKFERLET , HER—ILESAVDHE
WMAEERTHEDA TV REICISCTERICRABTEFET . HFOREYY
[FYVRATFSYI L THRERETEET,

SHROERM: SOLCHHFERIMIETRRTEFEA CNIFSED))—RTF
ESNTLET,

Dorico 3.5 [CKBAHFFEBEBBDHR—MEL. FELTORMXETHEAINDLY
[GERREED—HMELTHFMNESETEFERTS-HDOEHEZHI-TELEENE
LTIEWEREAN. RYITRIZ7DRED)—RIZEWTIE. IFESHTEDY—IL
MR THELEEEINTVET,

T4 T4 ELVRYI T —N—Da T2
MEEASNHRBOIAV T VT HEEIZEDE, Dorico 3.5 TldayvsFoi vy
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BEEIC 2 DOEELGFHFREBMMNBMEINFELz, Y a0 TL—Y—NavToo0d
DORRIZIHot=Z&E, ©H2aV TL—NVY—RADTAT4P D\ E—Ha0 T
DU TEDLSITHD=CETT,

o a =N —Dar T g A —bN\UROREEFLGEDT YT
IWD=HIZEMT BIBE. LA IEIT)RvE 1L D/R—bE ERICITEHD IS
FYPRFIZEHO>TRILEEIEEINET , Dorico 3.0 Tl WEEMAPIH—k
NORDRATIZAVT UV VT ENTIREERRITE2ER T 5156, €3 TL
—V—TREKYATL—VY—%2FERATILENHYEL-H, SEZOFHIRIEAERS
hEL =

O 3 T—N—DaAVT oL TERMICTBICIE. LATINE T av DI TL
—7— (Players)IOR—U(2HBMarToo25 (Condensing) 12y avI2#HLL
EBmsht=-ItoarFL—r— (Section players)IDA T3z, [FaI40 LB
B9 57L—v—%a>T23 2495 (Condense divisi and adjacent players) |
[CERELET . AREEZEBZOME L avIZEI avTL—N—FlH AT
YT IWRADOEELERLTWSEE. TBETIN\1F oo arTL—v—%0
TV MK’ (Exclude adjacent violin section players from
condensing)1&4>IZL T, Violin 1 & Violin 2 DarToo 0T 0HSEbED
TEFEY,

[F4 T4 LBEETEHIL—Y—%2a> TP 3% (Condense divisi and

adjacent players)|ZA>ICLTHBNIER (Apply) 1209 I L TEREZHEET HE.
LAT I AD I3 TL—vY—0BBRESN-a T 7 L —ThMay
T NS 34 IL—F (Groups to exclude from condensing) 11! Xk
RERSN, CCTHED RIS IVTL—V—0aAVTUIUTEPHIEHIELTE
F7,

€923V TL—NY—RIThRRLDAV TG T IN—TE2ERTEETH, hR4E
LDAVT LT EFAESEICY IL—T 2o arTL—v—&ynJdL—VY—%R
HSEBIEETEF R A TV AV TL—N—IE, VT T TEBESIIL
A7 IR TEWNIBEELTWDIBRELAHYET,

WEIZHLT, 27230 TL— VY —TEBEESN VTV T T IL—TOF gy
TS5 %% ZE (Engrave)] » AV FULV 5 FEDEE (Condensing

Change)ITEET HEBTEET . VL avIL—VY—RAOa>Too T F vV
A7L—VY—RANa T VT ERICLKSICHERELE T,

ATV ENEIL AV TL—N—D A=V VDRI TRTDOEYavT
L= —N1=V U TERTIHIEE. [a 21D LSHRTEFEHATH0HYIZ, Tunis. ]

FrElal I EELDONERTT , TDHIC. BEA T avolavFooyy
(Condensing) IOR—JIZFFHLWA T 3o THATEIVaVTL—v—Da=y
UETRTTF AR (Text for unison indication for section players)IAVBINSh
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FRATEIINLENRITARXTESLSICRYEL-, COTHRANME, TSk (Edit)]
» M5 (Staff)] » T1=YVIZERS (Restore Unison)|ZERALTT4 942 /8v+
—CHERTIHEEICHLHERINET,

TAT4oDAV T BB/ EI AV TN —AD T4 T4 DI\t —TF%F
FLEE T OMR. BEEL AT IMIIBRCHABEDRHMENEZONTLET  EEH
A= DB TALTAON FREEZDFEANEBITTEIRAUMEERIZIRU., HHED
EPTHRIBMR T ITE5T4 T4 OABDHIRIE. BEMIC A=V OEFRTEOLN
FI, INFTH IEEERRAITLETTAT O DORNBERTT DEROYERST
CEETET AV RRIILAVRIN—=FD O DERDREIZES E>TRERINT
WELz LOLTA I PRERDO TV B FzITH R—bEhfzZeIzkY,
NP TESLSITHYELT =,

TATADDAVT OV TERMT BT LATINFToavnlTo—v—
(Players) IOR—T(2HBMarToi o4 (Condensing) 193> T HiLWVAT
2aulw49arFL—+— (Section players) & T4 942 %V Too05 3%
(Condense divisi)1FzI& T4 TP LBETHTIL—FY—2a0ToI0TF 5
(Condense divisi and adjacent players)JIZERELET . Violin 1 & Violin 2 A%%H
BOAVTOL VT T I —THELITHETHILE0PHIE. EE01 R BTN TV
KTHENTNDEED 1 DOERICRIIINDSSITTHICIE. TBEET /14
YotHavIv—Y—&ar 7T 0T MRS (Exclude adjacent violin
section players from condensing)JHB%IIZLET,

Dorico DT A T4 HBEDFENAIZELELECATUWEWMES . ARL—30v=a7
IWDRNBRECLLTHERTHEERTTOHLET,

yaT4 9423y [F49142% 4R (Change Divisi) ¥4 7A4S TYYRLE 1 8L
FHEELEEE . VIRMND T I4PavEavFoivdhoinsh, BElI2EnsE
NI LEERAN TN UANDT4I230DERD LICRTEINFE T, B, vA
TAT42aVEFETOALT UL BERNAESNDI2D. BICEMOERTE
RSN INILBERICEZAONET,

AVTOVVTDEE TA4D40DEII AV DEEF DT ——DHEHEL(FE
AERLESICaVT oI TEINFETH, LKOMDENLHYET, VATIEEWLT
1J42av(E, JEFIZEFREL ALKYRATIRBEWMED TIP3 éarToioy
TEFET, Ta4JqPavREN 1 DOHRIZAVTUIUTENEE=HICIX. BYE-
TWAIED, EBELEFODILLVETIEHYEE A,

BARAIgeRa T VT E T 5812, Dorico TIETAI4ERIZTRT
HHIL—XERLGENFET,

FHTAVTUIUY: T4 94Dy E—CDYATIFGENWT 49420305 ED LS
2OV T T ENEHMNIEELEWLVESIE. T4 I DB BEIEZFD
BTERELIIARBEERIRL. [BE (Engrave)] » MAVTULV T DEELZER
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(Condensing Change) 1#RRLT. AVTUI VI DEEZERLET . 52475
O avTL—Y—0aAv TV OERERDICLTHL, FEHAVTUIUTE
AUIZLET . THEVATIEBNTAT42aVNENETNEFOURMIRTRIN,
BFDVRLD 1 DFELIFEHDERICENY L TEHIENTEEFT . T BL2DY
ATL—Y—%a T G 7 N —TIBYETEDEFESTKRLAZETT .

=ELYRTL—VY—RHOFHaAUT ULV EIEERBY =BT I« ERIZ &Y
BEDTAI4DAVNERINSE, AVTUV VT AEDEETHEESNTLVE=F
BarTo o T EEMERY ., BERRICKAREEDIVTUVUTIZRYET,

TL—V—,LERINIL RIS, TAT42oDRvE—2DTL—VY—5X)LiE. 0
TV EN eI I T —RICER SN SN LIEEREMTIEHY E
FA TRTDT4T12aV M 1 DITEMHBINTWDEE. T4JI423> DRI
Fdiv. Q& MNRTEIN, DEISN =/ =D DR EZICE T unis. DA BRRENET,
Frzn\vtE—UhRBlehiztd. ERICEEOABRISDIETI2ETOLOMI=Y
UDMRWTWAESIHIBE X, Ny t—C DR EIRR B ICH (AR A Tunis. |15
ILWDORTRIERITONET,

1 DDERICT4 423V DINERNRONDGEE . FE—EDARFORIZTI
TA>HKBNERMDHDIEE. TNENDAS>TLBDRAEIZdiv.iETaT10a0F
BFELIFBAMEMAINILNEZONET,

AT ENEYATL—N—DTL—Y—SN)LERIER, VT TENT -
TATATDNNE—2DTL—FV—SRILORETEEE—FDTO/IT(/ARILT
EEETEFS, FEFMERT Hide)lDTO/IRTFT4ZAUIZLT, SRNILEERTIC
HTEET,

EROERDERIANIVIE, HERABMED TIP3V DREEZRMLES,
BRIV UDREETIHFEDIGE . BRINNVIZETA4T42030DESLLFIEE
FNFEEAD MEORBEEICOV T VT INEEENRIRIINTLDIEE.
IRNIZETA T4V DEB SO EEN. EDQT1J42a0NEDERIZENY
HToNTLSMNRENET,

AVT IV EINITA T4V DNRvE—CDERINLE, BEA T a0 OIHR
SR)L (Staff Labels)IDR—CDIRBOVARBRBEETIHEEOHERIAIL
(Staff labels for identical adjacent solo instruments) 1A 7> 3> NDIREEE /K i%
L. BEICHEUTERDTAIAPERIZL DT IL—TIRN)LERTSELNET,
AV T: 202 avTL—N—TA VI THROEENEYLETOENTLDIEE. 20D
T—N—[FF v TERRVFEET HHEDI T TMLIEBRNSNET,
SEOER: COV)—ADBRTE, T4J42D/\ytE—20ar 7o 0T 12EL
T . SBOT7YITT—IrTHIET I FEDHBBENKOMHYET . FT.50DL
A=Y UREENCRAIBLTCAY TV TSNz TA T4 DI\ —DI2F2HB
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25—, - ZOHIEFABRS— (IR TEE Y A, RIZ, —EBOKRR F T
1 DOERITYT2—RENFTLTUL LT ENET 4945 D1t —II (%, BIFE
WARTENEH A, BRI, 12V ETAIAS D/ v t—S OO ERICHEE
RIFS. B8, AESLUHTFREOELICET SEEFOMBEO—HAZOYI—X
[CHRAELTHEL. 0 Foo oy OBEIEDLT TSNyt —UIcH
BERIFLET,

wA=VAG ¢

Dorico 3.5 [ZI&. TANT A DIREELYBENDOMEMIZT 5O D—EDHEN
FASNTOVET . SRR TONRTA R ERORBRERFNETH . RLEEL
DI, TASTFAMADNFEEORE (DFY, TOATFAOEENBEDL A7
IEDHIZEETEON, F=FETRTOLATIMNFET 20 (BT HEMD
T4—R\w o EFIEM RSN 2 ETT

NEDFHLLVY—ILIZTART, TOnNTANRILERN=EEFD L BIZR RTINS,
HLGEMEIN=N—SFIETEET,

A—ALETB—NIILOERE: 7ATLIZERESN-TONTOHBIZ(ETB—/NL,
DEYZDTATLORTREINDZTRTOLATITCENICEETIIDLHNIL.
—ATE—AIL. DFEYZDTANRTADERESINTLATINTDH, TDT AT LI
FHEITLHEDLHYETS . FEFEDLAT I TRIRSNIBFEDEMIL—LF
—VTDH ZDTATLIZHETDLDEHYET, fz1ZL. TANRT1DEZF IS
LIzEEREBRLEEEIC, ZOTONTHTO—NILICERSN DM, Thétn—
AIVICERAENSDN, —BETRETSDOEBETEHYEE A,

TANTANRIVIZRIRSINFZEZIZENEFVIZT 2O DRATARRAYF AL
BE.F070/8T74135 80—\ T, CNIETRTOLATIT. BIZFDTAT
LIZERASINFE T, TANTAIZRATARRIYFRH->CREE—FTRRINDIES.
NFTO—nLEO—DLEELTEHYZAFET, TANTAHNEFEE—FTLHERT
SNEWMEES. ZOTANTaIEA—AICLMERSINT . BEIEXREO—AHILEE
B, DFYREDLATORDBREDEMIL—LF—VICLMERINER A,

NIEERLGDILATIOMNEDTATLORTEREENDSELZRMEERTIHIERIC
BBAGVRAT LT, IINARIATENR—FEENTNITRELESNINEEERT H1=0
IS ENDOTAS IR IFAINEBBELLLENIEEZBMELTHERISATOEST . L
L. B—AILICERELETaNTDEREEET O—/NLICEIFHIENRBEIZLED
BEIHYET, CNETIETFEE (Edit)] » IFANFosZaE— (Propagate
Properties) &R T A2HENHYEL Iz, CNITEIRLI-TZATLDTONTAZH
HEDLAT IS, ZDTATLNRRENSGMD TR TOLAFTIMIOE—T 51
D TY, Dorico 3.5 UETIE, KUL VT I TEFRLUAENAREINFELT -,

TAONT(EHEDIEE: TANTAARIL EBICHLGEMSNN\—OBRAIZE. TR
—ANTRNRT4DNRER (Set local properties) IO —xDARE2TA—AHJL
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(Locally)1/TFB—s3)L (Globally) 10 ®YET . CNITBEED—DILIZRESNST
ANT4%. JA—NIVIZESRELITENEINEFIRETED DT,

fEZIETNICKY, BRFERETBES DR (NTEUATERRMETRD) ITEET D
[EXRERT/IRB D RHA)L (Gradual style)IDTR/ST1% . NAARTEDNEHATHD
BEDOLAT7IMIFTIIEL, T RTOLATIOMILAEMIZTEE T, FHLLVMEZE
HRET AR, T TO—ANTONRT OZHREEE (Set local properties) 14’0
—/\)L (Globally) 1128 ELFE T . CCTIERFEREEE S D A4 )L (Gradual style)]
DTONRTADEEZEFTDHE. BRELELZENTRTOLATIMIBERINET,
[EXRESAEE R B D REMJL (Gradual style) IDIRNILNAFETERRINDZEICHE
BLTLZEW, Sk, Shdyy o—/N\ILEgEHEIERESN TS a—Ah/LTa/NTy
ThHHEETRLFET,

TONTAEBRETHEEIC. COTOANRTAHRDL AT INTERRICIRE T SEEE-
TWAI54E . Dorico [FIA—ATR/ T+ DOENREER (Set local properties) IDIR
ADHREEZERBLT. MEOEADEELTRELET . /0— N ILOHBENERSH
EEE. Z0TONTAIZET TR TOA—NILOELEIBRESN. FO—/ LD {E
DETRTOLATIMIRBENFET, —A. TB—HLTR/IT DO REE (Set
local properties) |AhITA—AJIL (Local)lIZERESNTWAIHEE . BRIZV O—/\ L%
HEEOTO/NTADEREINTNDIEETEH, ZOLAT7OMIEO—hILEERHIC &
SZTONTADERESNET  A—NILGEHBEOEIXT O—/N\)LEEEZ LEET L
THRELFT .

TONRTADEEDRT: TONToN\RIL EEIZEHLGEMSNIzAA—DERIZIE,
[%&R (Show)lITBF BarbO—IL—KABYET, ITqIL2—F@ELTA—HIL. D
FYBREDLATINELITBREDODLAT7IOMOBREDEMIL—LF—ITER
SNBTONTADHERTTAHIZIE. TA—HILDH (Local Only)1Ex9)vHILET,
T4V EA—FBLTTA—NIL, DFEYTRTOLATOMIERHINS IO/ T DH
HRTIBICIE. [FO—3)LDH (Global Only)1Z29)vHoLET . TRTHTON
TAERTT BICIE. TFTRT (ANIEDIVILET,

TRNRTADITAIIE— TANT A7)V EEBIZFHLGEMESNI=N\—DERIZIL, &
RRVIANHYET , CNITTANRTATIL—TFLFEL2DTANRTIORADEK
XFEANTBHE TANTATL—TELIVELZOTONTAD>55—HTELDT1=
(TERRCTEET . BALRDTONTAOBREEDEXFLEITTLRREZEETEET,
FEAFEREERLTCIBERBIEANTEHE RRNTEBEMBAIEYE
(Playback start offset) IO TA/NTFA DAY AENET,

BRESN=TANRTADHTIE—: TANT ARV EEBDN—DERZH S5
[CHEST-—DRAVEFERTHE BIRLE-7ATLATRAEA VITE>TLNS T AN
TADHERTYT DM, TRTDTOANTAERTT N ETYVEZIONFES , ERE
ETONTARENTATLDIZE ., ChEFATIEERICAUIHoTNSTON
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T4Z— B THETEET.

70/ T4MO3aE—: Dorico DB/ A\—23>TlE, TRE (Edit)) » IFO/71%F0E—

(Propagate Properties)ll&. 7747 HELAT IR CERLIZZAT LS. TDT

AT LDBRTSNDMD TR TOLATIMITANT1ZIE—T BEWSHEETLT =,
LA, ZDTATLORRTINDLAT IERDOSHFRICHERLIZEE. RO

ANTADENFHRLATIOMNIBHMICOE—SBILIEHYEFATL,

Dorico 3.5 Tl&, 7O/IRT4Z 5 O—/NLICKRET HIHEENTTO/NRTaZaE—
(Propagate Properties) IOHEEICHFERASINSLIITHYELIZ, ShITKY . 74T
LNRREINDFLOLATOREENSERLIZIGETH. VB—\LETa/nTy
DIEFFLOLATOMNIBEHMICHEAINDELSF AN BONET,
TONRTARTEIZLDRERME: Dorico IZIXTANTAERTET S ETE->THERE
SHIFEIFELBEREIHYETH. ChoDEETRTIIIA—HILTRIRT1DH
B&G5E (Set local properties) |IOIREN RSN D KIITHYFELIz, A ETA—
HLFTanTF OREH (Set local properties)IHIS'O—s3)L (Global)lIZERE
ShTW5i5E. TRE (Edit) ) » T7UvT (Flip) ITEROREDAEEREET HE.
ZOHREFEFMIZIRTOLATINIERHINET,

E#IZ. B EE—RCERICETEITATLEFTYOORSYY CRERET S154.
ra—ALFa/ T D REE (Set local properties) A4 A—/3)L (Global) i
BEINTWSE, ARSI O—/NILISERINET,

MROFBRT/IFERTOER

LAT AT ar DIEEARDAR—I 24 (Vertical Spacing) IOR— (21,
THDEREELATIFCERT. TRTOMERTERT. RUOHELUNADT A
TOHEETERT. FETRTOMBRIZRTOVWTNOEIRETESAL T avn
HYVFET . ZEHDOEROFERREENS. BEDTL—V—ZRNTHILLIEET
EFETL(BN—2av TR ORI aVDEHIEFITEZEADRREERTFICTS
(Hide Empty Staves) | TLzM, BNA—23a> TOEAMHIETEERORF/ERT
(Staff Visibility) I&5>TLVET),

Dorico 3.5 TlE. SNoDL AT IR ADEELHEBERUYDUETLEET S Y—
ILHDFISEBMESNELz, ChEFERAT 5L TORBELUET (EBTHLINESH
[CBEHET) RR/IFERTRICT HEREIEETEET , CORBEIEROFEIRT/E
RTDER |EFENFET,
FERTERTOEERL. LTOVWTIAAODFIETEITTEET .
» EROXRTIERTEZEZEETIMEDOER. KFOZTOMD T AT LEZERL.
[#R& (Edit)) » 5% (Staff)] » FHROFEIRT/IERT (Manual Staff

Visibility) 12 #IRLTZDEICHEBERIYZEEML., FHEROFEIRT/IE
& (Manual Staff Visibility) IOF A 7R ERRLET,
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= BEOHEBRYYDHARERIRLT [Return] M. HAREETILYY)
L TCI#ROFHRR/IERT (Manual Staff Visibility) IOF 4 7O5 %
FEET,

UTDEIGFAT7ATNRTESNET

Manual Staff Visibility

Cancel 0K

ZDFAT7ATRYIRIZIE. FDERBMORRSNDERNIACRTINET &
MOERNENY L TONEAVARIILAUS (ET7/DESICKEREZRANDESR. Y
FAFIV I3 DTAT4OEFERTHTL—v— ERASBMINFzA VX9
AUREE) X VAMIEHRIBRICHADN TR RSN, FERICIIFBIIMHEDOTILI7
RNYMIKBFRIMFEET,

ERORTFERTEEETDHICE, FTERITHIET DRAIARR(vFEFUIZL
T UTD 3204 Toavhblh b a&RLET,

= Jtybk (Reset): CCETHNTHOERDFHRT/IFERTOERERIZLD
EFEZZRENHIBRIN, COMBELURE., EROKRTIERTIEILATINT
2aAVDEFEICHSILIITHYET,
* IR (Show): ZETHINESIMCEHST | COLLE LU ILEER AR GIRY
[CRRSNFET,
= JERTR (Hide): ZZATHAINEINIZEHST , ZOLE LUBGIEEER AR H
BIZIERRICHEVET,
TOAVN—EERTIHE TATOEROKRT. ERE. FLERED vz 1
D)) TEITTEFEY,
EROFBRRERTOERL, HERUYZRIRRT LMY ESNE T, TDHL

EBICHERRYYZEERTHEE, EROFERT/IERT (Manual Staff Visibility)
DEATOTERE BRERDRASAIRR(YFEFTITLET,

ERESLBAOLES

WEREE POV Y —FNUR FERRGEFHEREOT oYU TILOE=HDAIU X
HILAVNIS—REER T BIHEE . BILA VR ILAV DB ICSESELBIRAICLD
IN—FEERT BDENHDHZEMNZUVTT, Dorico 3.5 TlE. HENDTL—Y—IZE
MD/IS—hLAT 9% 1 DLUEERL. ZD/N—rOEBEESLUBRAD—AF
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EIEMmAZE LEETHILET. CNhEHEICRBETESS SO TLET,

FIRN—FLATIOLDER: TR/ NA—FLATOREERT BICIE. FREE—FIZHIY
BAT.BBOILAL4T7 Ik (Layout) ISRV T Bl 29)vOLFET, AR E T,
ZED/IN—FLATIMIETRTOTZA—DEY LB TOAET M, TL—Y—IFZEY
LBTONFER A N—MITL—V—%E Y B THIZE, FHLL/S—FEERTH10R
FoILARDTL—Y—IZB T B FL—v— (Players) I/ ARIILDFvI RV I R%E
AUICLET  /A—tRFTZAD/A\—E (Empty Part)i1h o, BELATIMIEY
LTONTWSTL—V—DOEFIBBMICEFH SN, CRITIFADRRYILAV D
BIANESHLNET,

MERETIE AVRRYILAURIS—RD 1 R=THDELABLUVTNLUBBR—
DAYE —|ZRRESNBAIVARYILAVRE I {@layoutName@} Dh—o % {FEH
FTREO HLOWA—MMIEHFROBRAZERTTAICE. EEE—FDILLT7IR
(Layouts) I/SRIILTLATIREEZ TILD)vO L THIRELET . HILLWL AT RE
275y hE B2 FERATIE AL, (@flat@) D—Y2FEANT HE. BEIMIZTSY
FESICEBLTLATIMIRREINFET,

FATATERL FRNA—EERLEZRIE. RETE—FDOILL7 L (Layouts) /8
FILTEDN—FDPERSN TSI EZHERL. BV ILTIAVTHRMAZ A —D
SIEEEEELBIFD EEE (Clef and Transposition Overrides)Z&RT BH .
5% (Setup) P I FEEEB EBAD LEZ (Clef and Transposition Overrides) |
FERLFET, COBBETHEICHERATHEFRASNDIGEE. BREZEDF—KR—
Fia—bkAavk (Key Commands)|DR—U THRALDF—R—FLa—rhybzE|
YHTHILLTEET . ROKIGF AT AT BNRRSNFET,

© Clef and Transposition Overrides

Instrument Transposed Clefs Concert Clefs Transposed Transp. Concert Transp.

Transposed pitch Concert pitch

Clef for first staff:

Written middle C sounds as:

BATATRYIREEBD—EIZIXLATIMHDAUARSILAVRE, FNHIZERTES
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NTWBEEZEORBENIRNTYTENFET VRS A VRIS ILAVREEIRLT,
BATATRYIAD TENZHEA T v TLEZOARNRERELET,

TIHIDOEMREESZELEE: MHRECTE. SHESEIBFALI-RAITTELEET
KRLEBEATHRILLONRTINET M1 O&)G) MRDFERECE (Clef for first
staff) IDEDRASARRAYFEF 2T 5L, BT (Transposed pitch) IO TD
BEEREDELIZ—DENILRYET . [EF (Concert pitch) IO FTDRFARRA
yFEBHIZLEWRY ., TBBF (Transposed pitch) I TEIRL-BF & LB 1R
BEEEOMADLATIMIBEREINEY . REICEIELGLIEHNEZVELT HEHE
(%. =& (Concert pitch) IO FTORSARRMYFEB L TEIRELEEFERLT
Q=1 AW

AVARYILAVNZ 2 DDERIHHIHE . TR ETELIZI—D 2 TTHLERIZA
YFET, EBICLTHET—ATIMN 3 DDERLHIAIVARYILAVDIGE X, 31T
OMNEZHYET,

CCTABSILEZDREIE. LAT7IMDETO—DFBMED T 74 /LD EEREE
FITHEEEZFT L, 70— DR EICHATRMAGENER RS IMERSN
TWAEEE. CORENBEINET, TNLUEOIO—LOEHNEERSIE. &
BEEBYRTEINET,

BHRADLEEE AVRMIAVME BIRALATIICHEEDOSETRATE. EE
LAT7 IrTCIIMEREDA VA= TRATEET . A V4—TOBAIXE YD, ¥4—.
AVMSINR FEDTT—. BEHOREEBELIUVEERERLGEDA VAR ILAVE
TEAINET, INODAVARYILAVMEIEFEL T, BELOEYFHIS 1 94
— I AV FI—THALTRESINFET,

858 (Transposed pitch)J@'F@Z%*fPZ*f‘ﬂ‘"é?J’.‘/l'L,'C BIALATIRT
DIEAERELET, LA E Bb DIUSVRVEDEE EEDIFIL C ORED
& (Written middle C sounds as)Jl:J:er3JLaQEL,35'd'o BREFVAI—TIER
EVRyIRICEEADLTEET AN [ 1] F=E [ 1] TEXERT M. /\FILE
JUVILTCHEF R TEE T, [Shift] ZH T LA VI — TR TEFEHBTEET .
EELATIONTHII—TBIAZEMIEET 55 EIL. [EEF (Concert pitch)IOTF
DASARRAYFEA UL TEYGA VR —TERELET A LTV RS ARIE
rcsl. Evanixlcsics& e LEzd,

ERENDI—FF(TTSLD—KE

A—RFATISLIF. FE—OZFDMDILYNEBDILYMR—FTHENI—F
RAV VT EREZZBDHIREEGEADED TS, a—RFEEDEIITERT HREN
ZEMEICIEZA D LETESBIZERNTTN., BFEOR—AILPOF—FR—F/N—+D EIZH
OEEREDHAXTHIRITEE DEYDAR—RER>TLEVNET , A—KEF(4745
SLILEE. LEBEMELN=HOI—R PRSI EFERT a7 0 Ry TR
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HiCERASN. Z0HE.1 D 1 DOIA—FESOLIZI—REFA(T IS LERTT S
DEIHYFERA, TL—V—LEDRIL VT EERTINENICIZIER SN DT
. BEFI—FREFERSEITTTHATY .

LIz > T 2 RITh > Ta— I (7S LERTTHLY . AVIPRYTID
EEDOHRME T—RUGFEIRHD. ZEORVOMEEBEDO LICO—FEFA4T7 T34
ND—EFRTITDIANKYNENTT, CNTRBERICHDELEEARDAR—IY
THEHTEDLLEBIT. FRYRMIIRAL T DT T T+ YET,

Dorico 3.5 Tl&. 7A—T#EHATHI—KREA 7S LD—EZRYIDMPED EIZ 1
H1)yHTEMT BV a—arvNEBASNTLVETD,

FERINDZI—KRFTATISLO—EZEM: A—FFATISLD—EEXZRTT DI
. LAT7 ot Toavicmliamsniz-a—rFEsLa—Fr44755.L (Chord
Symbols and Diagrams)|DXR—J(ZHEIL. [7A—THERASNEI—FF(7I5
LZEI7O0—OBAREIEICFET (Show chord diagrams used at start of flow) %74
VITLFET . UTOA T avIckY, a—FF A7 IS LDV A XEFLBEINRESNE
ER

= [DO0—OBREEDI—FFATITSLDF1—=2% (Tuning for chord
diagrams at start of flow)lI&FEAT E5F1—=U T 4EELET . MHETE
TIRIRB A —KXB—Fa—=24% (Standard guitar tuning)JIZ#>TL
FIMN. TACIIMIERIN TS F A LEBEDF1—=UJ #FINTEFE
ED

= 1 f7HEYOI—FFAT7 TS LORRE (Maximum number of chord
diagrams per row)Jl&. —&E®D 1 TIZRFTITHA—KRFAT7ISLDRERH
EHRELET . -EL. R—C DR, a—FE (477 SLDERE FURREER
DAEHEIZKYIDENERRTELRNMES L. BFKREZRB T 5120
2.1 T7HEYDI—FZTAT TS LOBIEIREINET,

» [O—FHFAT7HTSLDRTEE (Scale factor for chord diagrams)Jl&. %
EF T3 pla—K& 4745 5L (Chord Diagrams) IOR—U TEELT-
EIZHES ., BEOPICI—RFEFL—RICKRTTHDICHERASNIBAESA4X
[ZxtL. —BICRRT DA FFAT IS LEENEZFLREIEHEILTE
TYOMNERELET . JO—DRRUED—EICRRTHI—FF(T775
LlE, BEODIZRTTIEEDH A ALY DLKRECT B, a—FRRH
FLOIRYET,

» [O—F&A4F7ISLEDIERE (Distance between chord diagrams) (. [
CITICHAHa—RFAT7 IS LBDKEERHEEZIEELET . COBEECNLIED
EORTIZIE, BESZTEDILME (General) IODR—C TERINSEEDA
EHEMAERENET,

= [{7OREF (Distance between rows)lld, A—KE A 75 S LD EITDRERE
ZHRELET,
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» MA—RS5AF7ISLO—BLOTHS LD (Gap above top row of
chord diagrams)Jl&. ZA—RELA. 7JO—RELMNIERTDIGE (L HEE
JL—LLEintDRBERELET .

» [O—FH&AT7TS5LD—BETOTHLT DR (Gap below bottom row of
chord diagrams)Jl&. A—FZ AT IS LD—BF T DITEEED RV DI
EDMERERELET .

A—RFAT T SLDER: a—FF AT TS LI, 7O—FAMED—EIZ, FFEIZHE
AShBIEBETREHINFTT, —BICFEETERATIIRTORIL T HRTRS
NFEITH. ENETNEEHSNDIDE 1 BT OTHAOH., BT LLHEERT DD
IEF TRARSN TS DITTEHYFEE A FE2VAME, ZELDI—FESESER
LT, EDI—FZEVWDERTOINER T OREAHYEYS

—BERNDOI—RFAT7 I LDOHEE: 70— EIC—ERRINLGI—FFT(7
T LDERCHER I TEFEAN, EEOPDI—FFT AT IS LERET DL —
BERADI—FFAT7ISLLEHFINET.

FASNDII—FIAT IS LEHMOABMEICR TS SIH5E. BFEFEEDOTDD
—REBE—RICERTLEEAN . FBNED—EICRRINIRAO T EER
FTHLOICIE, —BMICEEDORICO—RFATISLERTTIDLELHYET .,
DEEFREE—FTITL—Y— (Players) J/ARILHBITHEWNET, I ES
MHARL—2303 a7 IILESBLTIESL,

=8 ERENESGI—FET AT IS LET7O— DRI EIZRTT HHEEE. g
[FEXTEATDETIHEALGNIEEZSTITOHLET,

TZ499DRFA4R

DT T )r—2a 0 TRFAAVIERIXIY—REERTEEE. BIRTB=HD /)
SHEENBELLGDIBENHYET . INETEH . R—P 2K LYBVEEOEEH
L. DLFREDOINSEETL -, EEHTEELTERTRT H=-OITE Y GR—
CRELREBREETHI-ERLA TV NE/ERT %H . Dorico hoEEHLIZTS
TV TS99 T TV —2avIc kB RANT O RETESBERHYELI,
Dorico 3.5 Tl&, BFEE—FT LR KYNSWEE DT 571005 F R HEIZE
EHITODY—ILTHD, T ITAVIRTARDFZICBASNEL . T5T497
AL RIFFEEDOR—EHEB TV HEL-EETY , TR IR GMICRTE
SNBH. ERRISMETEEZTHLTEET . RFMRIZEER TN .

BB DL&HiZE T, Dorico THR—,ENTWAEEDT T4V R
TEZFHEFT, —HOEKXTIIRBEOCHT—/AEELEIRTEET,

G549 RSARADER: T5T4VIRSAREERT BIZIE, FEE—FIZPYE
ZC.BEERDY—ILRYIRIZHEIT ZT4IIRTARY—ILEFUILET VY
—ILIRYDRIZT ST4VIRFA RISRILINRTSNET,
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[RS5AR%EER (Create Slice)1&x9) v L, EEHLETLESEEES)VITURR
SYTTHRELET . FIvTT5E R—D LIZERDIL—LARTINET . 7D
ARIVER T E TL— LD EEINE T, IL— LDV A XEEFETITHEEH
BIBHIZIE. IL—LDOBBEHADEZTHEIVRTIIYILTRSYT 50, [Alt]
FHRLGALGKRHNF—ZFEALET (KELEHATICIE. REFFIC [Crl] £
[Command] Z3LET), IL—LD YA XERHETBICIX. BBROBLEAICH B/
URIVED YO LTRSYT T 5h. [Tab] F—TNAURILERE—FIZCAY, KEHF—
EHEALTRERETS/N\URILICBELET, BRONURILEEFIKEICLTHS,
[Alt] F—ZRLEASEMNF—2FEAL TNV RILEBBTHIET. IST49IRS
ARIV—LDYAXDNERINET T ITT1VIRTARITL—LIIDIEEDIL
—LEFEGY REDR—CKREADNMAIZEERTES-O. RADMAICHES
NBHZELHAKRIFNMOPIFNLEFRICEDONET,

EESHLAT AV DEE: TIT19IRFAREERT DL FEET—FEM/ RV
DT FTAVIAFAADIV AN ENENIMEREINI-A—D DIBFICRTENET
AFAREEEHIRICERTEI7MLVERERETHITE VALD 1 5lvEFTIL
2oL EEDEZREANLET,

ASGAREERTDHEVANT DA A—)LIZIE, ASARDEETHLETHILE —
E.ZDMDTONTANRERENET, MHARETIK. VST IRIMR(ETAD
IVRTFAIVERILTANT —ICESHINFET N, CCOTANT1EFEHRATHILT
BDITHINE—EEETEET, O IVNDREFSHERLGDIGFRERTET L. T
NUBRMER T DRTAADT IA IO RESAIE. REICEEELLZI7HILE—(25Y
7,

EFHLIZIE 4 DOBANAEINTOET . EVMIYTARXD T 5709 RHA 2
D (PNG B&U TIFF) RIMLAKXD T Z7499FRH 2 D (PDF &KUY SVG) T
T, EvbT T AKXDOEKIZDONTIE., FEHTLMEEE (Resolution)l% dpi T
ECEET AIMAKXD T STy BRIEBEBLGY A XL KFE/NTES2O.
PDF &Y SVG O HEBEIFIEETEF LA HNTEIT 57190 TOIAS—
(Colorn)1FzIEMBR/R (Mono)IDFBERIE. EOBRICTOVWTHIEETEET . (AR
(Mono) JZF#IRT BIHEE. CNIFEHRTHY I L—RT—ILTIEEWL =6, BTIEE
WPATLFTRTEEHEELTEEHINSLITEELTESLY,

AFAADEEHL: IRTORFARZEETHTIZEH NARILDYARASTRSAANE
RENTWVENWZEEFFEZEL, NRILTEHDOIFTRTEEHL (Export Al IRZVES
Dy ILET, EBLIERATFIRAD—HEERLTETHIHEL. ESHITRIIRE
JRAMMDBIRLET , /AR TFEDRENITHRR—F (Export Selected)1(ZZ
HY. IhEIVIITEEERLEZASAADANEEHINET  UEIRICSRTICE
EFHLERASAADH GG BREDI7AINELEETINESHAERT SAVE
—OMNRFREINET,
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N)OYRREAL )LD 78— 5

NUDYEOREL FUE . BEUE TS — LHEOLA—TA2 5 £y a  AOR
EABEHET 2HE . DT LN ABRKREO T EHIEEFIEBHARAT 50—
EOBEDBY AT 22/ S~ EMESE 2D, FHICBOF SR
<7

AVEL—S—ICRDFRENBGTHUUA. - FERFENRI SN - ERRKICF TR
SN, DEYER—VIZEHOMNCORE-HDERENSI NN TIEL, Bk
[FEEDBRICIE, AT SERRRERT DDOICEKEDEEICKVICRER
TWELEA, Fa2—DBR—UDEHYDL HEROBRDOYIZELMZDONTIE, SFE
DERIELERBATLZ, ZORR. F2—DREDHYICIKONZEADERAHDHE
3. REOHEOEDYICEBDAR—ZANHEHESZLB LLEHYFEEATLI,

CELLO LOCKDOWN IN LONDON

1M12

“We don’t need no stinkin’ virus”

BREOFIENAIVEa—F—bShi=&d ., REFESBRO—EL. FEXTER
ENFN—FEDZDRFBERMLEEITHZEEBIRLEL-, VEDDER(E, B7E
BRITOB#EHSEMEBRT 5=OTY, LIVEDDERT, ZRDERLHHE.
BEERENAERLBRZERSINOINMILLNGVENDF1—Z2EERAHDHENS X
RBBEA) YN GoNDBEENHAH=DTY,

LA, BRSn = AR SMRE R T2 7 TR S LIS E TR
LBN—IELEETHRICEBEEENFHRRECIDI—EDHREETEOLENHY
FIH. ZTOVTHERFEADNY IANRETHIRAINBALET,

COFIEEFIYRRTESNDOEEEDENEDIZT S5-I, Dorico 3.5 [ZIE, =
DESEEFREL AT O REREID I )y TER TESHBEENEAINTLVET,

» REBEOHENFEETRICEE > TOERVLRYEHFZZITEHENKIICT
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BIZIE LATINATLar DIEFDAR—I S (Note Spacing) 1D R—
CT I7n—0REOMEICHIERIZZERA n% LEDFE (Only justify
final system in flow when more than n% full) JM{E% 95% 4 EIZEREL
F9,

» LAT7IPDORBRAR—CEZAQERTEDLITIE. LATIOTavn
[R—IETE (Page Setup)IDR—T(2HBHI7A— (Flows) o3> T,
[IL—LORAZZEADERTEHS (Fill frame with blank staves)1%#4
VITLEY,

» RRIC.EADERODTIN—TILELATOLOETTHHRICRIZDEE.
EHDRREZERIO—LRICHBTERERT S (Show blank staves in
systems identical to final flow)1Z#4>IZLET,

= IO TLEEOZEADERICIE. B EEMAERICHIETEEHIEEN
REASNFIN. BEMBREBFTEXTLAVGEEITERREZSOHEL
(Exclude clefs)1&AUIZLET,

EAD#ERETERIO—LRICHEETERITRT S (Show blank staves in systems
identical to final flow)1Z74 7129 5&, JL—AIXEADERTEOH LN, FEBED
. KEMO/NMEIARRENGLAGYET . COLEIEADORROERROK
(Number of staff lines for blank staves) |Z#m&Ed 5L, ZEHDERDERBOK
ZIEETEET,

EHDER

N)OYRDLA—T 42T viavDBEEIZEDLE T/I—MEDOREZICEBDHEE
ZEEEMT HHEEDFMEREL T, Dorico 3.5 TIXZAD AIFMEHE IR
TESSIIGYFEL, 2R EEHDERTHEOONFA—DFBHHRICERLT.
NERNRIBZTEET, 7=V — b OZTOMDBHM OENRIZERT 5584, RLHE
HBIIR—CDREEDGHICEADEREERLT. E/ENEZADILIICTEET,

EHDERTEOON-IL—LZERT BHIZF, LTETEVET,

= FBFEE—FRICUYEBZ.Y—ILRYIRADIL—LREY—ILEFVIZLET,

» ZHOR—JEFRERT I REDR—DICAR—REEY  FFvJ LT
FHROELEIL—LEERLET,

» 2a—UvIIL—LDELRBICHAITO—TAIINE—A_a—FFE. [Z2AD
f&=& (Blank Staves)1Z&V)vILET, FHIZDONTIE, 43 R—UDIoO—
(Flows)1ZSBL TS, ThIZkY ., FIREEIL—LIZEEMICEY Y
TonTW-Ja—AERENET,

s JL—LBEENBIRSNRET, TANRTFARILOTEHETL—L (Music
Frame) |7 IL—T DIEZADERTEH S (Fill with blank staves) &7 (2
LFEd,
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IL—LDESICNFESZLETOHDEADERNERINET  EROBMIKL. LAT
AT DIR—UEERTE (Page Setup) IDR—IZHRESN-TOADIILLHE
DREOESL [BEARDAR— Y (Vertical Spacing) IOR—J(ZERESN
FAR—O UG IZE2TEASNET , IL—LIZRRIIEEADEROMELTET
BIHEIE. IL—LDBEIEZERET L. [EEDFHERDHE (Blank staff count) IO T
ANTAEAVICLCEUGHRICERELET .

JO0—DREDHBELITELY, TADERTMETT IIL—TIETELR O, XiE
MEFFENMOFHMESERTTEEEA FINODEBHDERICEFIZANT
EFERA INODERITHZIA R LDLOTHY ., FIRIOHEBHELTLET,

Keda Indian Drum Basics QY™K

Keda Music Ltd. ED/X—bF—2vT2&kY AR DIEHRERTHHIIUNKRF 418
(B3T3 F=IL AT D R3Y) OERHUTILEybhREENFEL,
Keda Indian Drum Basics yrD &/ Sy FIZFHBOERZE VM ARSI, UL
TOEIIRVELTShTVET,
;3L (K):

= C4 (/—h 60): Ke ()

= D4 (/—k 62): Ge (B)

= E4 (/—F 64): Ga (F9)

= F4(/—F 65): Gi (B)

FSL (1)

= C5(/—hk72): Ta (22—kE)

= D5 (/—k 74): Te (E)

= E5(/—bk 76): Tu (Bf)
Dorico 3.5 DFMTOTCHRTIRTS (Tabla)ID/N\—hyiarFyhE e T 5E.
Keda Indian Drum Basics DY REN—DySarey I hBEMIZERINET,
AVRKEOEBEE R, 3 T5OMDAIURKREIZLBEHBADIY—X, TNHD
AV ALY ILAV D EEZEIZDOLNTO M. www.keda.co.uk =2 ELIZELY,

AN

JA—DOT I+ DINGHRAA T BREEA T as OIM#R (Barlines)IOR—Y(C
FLWATLavITFI+ILEDING#RZAT (Default barline type) AV EBMEAL, /I
EiRAA T ORI ESN TOELYNAICERT /D ETRIA TEI/ETED LS
[TRYELT=,

MEREO/MER #HEER) (Single barlines between staves) DA T av(E, EE

56 R— Steinberg Media Technologies GmbH


http://www.keda.co.uk/

Dorico 3.5 N\—C 3V ERE

@ steinberg

AT a ONING#R (Barlines) IOR—U M EEEEA T a> D NINMITER (Barlines) ]
DR—=DIZHBEL. TR IR ARADBERTIILL, JO—TLIZER SR EETH
ZBEIIYFEL =,

EHT PrO 0

K CHBEICRTTLEN: BEA T aVDIEHROTIIL—FE (Beam
Grouping)IRR—L DA T a T BT IL—THOAKEF (Rest in beam groups)]
2. EHTRB L VENTORIBAESR T LE TOKRFZEFA (Allow rest within
beams and at start and end of beams)JEWLERFEAFLGEBMENELT -, Th
FEIRTBHE AT LLYMERRLUGSTE, BT IV —T 2R B CRIBEREIETT
FFET,

BELA T I DIEF (Notes)JIDR—UDIFE (Stem)j£92avIZ 2 DOFHLL
AT a  —BRAIOEHEATFOREER (Ideal distance between innermost
beam and rest) JET—BRAIOEHEARFOR/NER (Minimum distance
between innermost beam and rest) JAGEMEN, BHT Y IL—T DIFIZAIE T HIK
FETHULEHONBEEHE TELLIITHYELZ, ChoDA T avE AT LA
LYbDI=ODREEDA T avIZEnENIETEEDTT,

RFFEEE 2 BHTY IL—T: IB/N—2a0 TlE BT IL—TATORFEFIT 5L
NEBERINTWSE KT T2L—L 3V AEOBRDOTAL—3aVEEL DS
B.BICUTOIIIKRFOMMETE 2 EHHLDEISNTLELS .,

%09

(e ! 1 1

ANV

d — —

AT ar DIEHTY IL—F (Beam Grouping)IDR—IIZHBHAFEE 2 &
K54 W—7 (Rests and secondary beam groups) DA 7> a I AIEELIRS | K
HOGEDE 2 EHERE (Preserve secondary beams over rests where
possible)JICEREL-IGE . COEHITLUTDLIIZFEEESINET,

KFOTAL—arhE 2 BHINRT TaL—av RN ZENEVENES. 5
2 EMIERUIN T ICHRIETEET S

F 2 BEHMOBESEOEMEL: BEFTavnlEHDOITIL—FE (Beam
Grouping)IDR—UIZH AT 2 #HrJ JL—F (Secondary Beam Groups)lt%
DAVICEFHRATLIUIE 2 BT N—TDFRTFAE (Approach for secondary
beam groups)IhVEBME., BEIMICE 2 BT IIL—TEREIT 50, F 2 BHE
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DEETITE 1 EMTIL—TE2HFTEINEBRIRTEET,

BRMZIERZEREONITLENOMER: RO EREOBIZIE, FEREITHE O,
EROEHZEIFOCLECAEHYVET, TCTIREE 2 EOFTRICHLTIE 1/4 RR—
A.3 EULDOBRIZHLTIE 172 AR—XDIERISBIRSNFET, CO5EREFIR
TBIZIFK, BEA T a0 ONER (Beams)IDR—J(2HAMER (Slants) 193
D3 FLLLDEHTDOIEF (Slant for beams of more than two notes) JDEZER
BLFEY,

=L BEMGERIC 1/4 AR—RZFRELZHZETL EHHOVT L DiRH —
BHMAIDRERIRIZES ESIHEM T IL—T T, BENK 14 AR—ZADIER & HHE
TEFEHA GELGS ENRORNBIN —FNMUDERRICFAR—ILIANE TS
CEEFELLBUKSURZHONTLESZENHY . ChEFFILT 5O DIRAAH 7=
OTY, AR, BERUBOEAADHEIZESTIE. 32 D EHFDEHAERDAE
TEDLBIIGEIE 1 AR—XDERITGEYET, Chid. EBROFAISCSUREZEIG
Wz®IZIE, BHT OZEMLERSEMRBICEDFIRIZKY., 1 AR—XDIERHIER
LU FERTERWNZHTT,

BEFEQOFIZIE. PLORMISHFREBEANLEEZ. —EMHEHELGVRANEEL I T4
HENHEIALTEM LY. CRUREZECTTHRONHEMEESREWNSIFLVET . C
NITIEC T, BEF T3>0 DOMERT (Beams)IDR—TI2HAM{ESH (Slants) o>
av DIEMEERTE (Advanced Options) 1923 vI(Z 2 DDHFHLWVA T arhEMmS
nFEL =,

» HBIOERBROAICEESN-ENOREL 1/4 AR—RIEMEZREF
(Preserve ideal quarter-space slant for beams positioned near the
outer staff line)1ZA (29 5L, BHDRBEGZEM 1/4 AR—XTHDE
. RAIOERTIRO—BMUDERBISH T HMUEICHIKNZEZ(FERGYE
ED

» (32 DEFEHOREL 1/4 AR—RIEMERFEF (Preserve ideal quarter-
space slant for 32nd note beams)1Zz#IZ9 H& FERDRAIIZH S 32
DEFOBHIZ, FBEH 14 AR—ZADBEMEFEATEDRSITHYET,

aA—REAT7T 5L

HRBLDF1—=2%  [ZEFa—=V 5 E#E (Edit Strings and Tunings) 104
AT7RT TILYNERDEDBFE I F1—=2 T EhRETA(ALI=5E. TS
GRDA—REAT IS LDRRIZEDF 21—V T & FRATEDLSIICHYELE, F
A—ZUT OERIL, REE—RDITL—¥— (Players) /SR DAVTHFARAZ
A—DHYITA=a—TaA—KF L7/ 5L (Chord Diagrams)l. EfzIEEHRAINfz0—
REAT TS LDO—ERICIK. LAT IO Toar DI aA—FRBEI—RF(TIT 5L
(Chord Symbols and Diagrams) 1D R— TITHEWVET,
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LT

FOA—TBFAMNEZTEELS: BEA T aVICIEFEERS (Clefs)IDR—T & FHL
WA TS avlFo4—T iR AEEEEES (Clefs with octave indicators) A
BMEINELT,

MERETIE, EWES DA VF—TBHR FROTF—IT—RHMIZERShLLE
REEDTOI8IRE) FEBINET . ChIE BRI DB IYENFLIIENTIZ
—J TR HEBDEEL. A V7T BRANEEHELSEHERALLCTHL, £0F
DRA—T CRETIDON— R THS=OTT  EAFEFEEDTF—FAI5—T%
FTEEMESEFEALTRETION—RTT A, EvanPar b3 /1N\X TR,
EDISIGERHLSEEALTEETIDE—RITEIHYFEE A,

LAL 20 HigF XI5 E. Britten 2280 —HOMEHRED., RLV/SvE—2I1ThH
123G 8 AV 3—TRICO D IREAEZLLTAH VI —TRANEE MR
AT BESIHYELIz, SNIEAV2—TBAMNEEBREOAN, FERLICT L
BHETE2FI3—TRIVEBENL /A XNDIENENSONEHRTT,

Dorico TIFZDRERAUMN Y R—rSNBKIHBYELTz, TFVF—THBHGEE
EREC S (Clefs with octave indicators)Z#IA92—THREBEIZHS (Respect
octave indicator) JIZERE T HAEFHILGYET,

BMEFRLSOAV5—TL T8 RWEAOH, FSFEISHFLEEOMIBOS T, R

IWoRNRIF) 2 yhENS TR RO /IN—FEEICFERASNSGEHMESITONTIE. 2

CDEGBHRTEHADEBLTEEL z LA XA TREELLTHONS/INRYS

DAV DREHRATIE, FEESENETRBOmMANERAINET, FERBIEES

EDEYF LY 9 BB ABRBIEIESTLOEYFLRY 2 EEiEicnEd, 19

ORI DN—FEICIZTENRESIMMERAINDEZEABHYELIz, CHIEDFEY.
EEHME~NBLS CREI 2D TIN. BRE— RN THAIEELDEYFLY 5 E

BUVRELERLY. 4 EEGEEINDSLDTY,

INEDSESFLRAICH ST BICIE, FATIFHMESTICELTEROERDOH
REERSTILENHYVET . ChiF. BHRBTETERTHERTEINSGHTO/NTA
[A458—TL Ik (Octave shift)1ZAVIZTEIET, SHESUBROEEEZAS
HBFVA—THERETELLIRYFELz, ChEN—FEDRIIITESIGE L.
1/ EIODRIBRAEICHARMGE N ER LS EEML TS,

=0 A

AV VDREEINI: BFEX T aonMarToo24 (Condensing) I DR—D
[ZFHLWAToaola=vyonRye—SnDTL—¥—5/X)JL (Player labels for
unison passages)|MBNEh,.1.2.3 a 31DEH3HTL—vY—5R)LIZla 3125
OEMEIMBIRTEDLSIHRYELE, CNAFETHDEEE. [TAIZFTTFH
Ar%£IERT (Exclude "to" indication) JZ:&IRLET,
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TL—V—SRNILDRYYXF: FEA T a>nlarFoo2% (Condensing)1dD

R=IIZHBTL—V—BEDREYIYXTF (Separator between player numbers)]
ATaviz Tar< (Comma)lDELAFHzISEMEShELz, ChixarToioy

SINFERDOTIL—NV—IRILDTL—NV—FEFEZ  BEICRLTIVITRYINS &

329 5LDTY,

INTA—IVADHRE: THRE (Edit)] » A>T o204 (Condensing)ihA 124
DTWBEEDNBEHRDANEREDAE—FAKIBIZHESNEL, LAT7IbDT
DTV DA UIATONYEZL, IBA—Car kYERIESnELT,

AVTFULV I FEDEBRAOIILE— HATURTIRE (Edit)] » T74L5—
(Filter)] » Ta>TUP U9 AEMDER (Condensing Changes)A%BMS, OV
TV REDERZFERFILFBIRBRTESISIZHEYEL-,

Fa—
TA T4 BFX1—DERK: RCEILavTL—Y—RNT, T4J123VhLR0T
1742V x 1 —FER TESLSITRYELT -,

FEEF

HEDAR—I UG DaE—: THE (Engrave)] P TBRORR—I VY (Staff
Spacing)] P M#BRDAR— 24 %aF— (Copy Staff Spacing)1&REiRT 5L,
[R—T (Page)IDREVHRY I ZADMEAES ., BIRPDERDAR— T DNUR
VT TIEAL, £ ECEIRPOTATLERBT 5E512YELT,

JH— RO 03]
BEE-RFOIO—Jq)LE—: EEIL—LELEADIO—TAILE—A=1— (BE
E—FTIL—LIRERICHERTEE) 2EALT. ZEIL—LIZTO—Z2E|VETE
WIEERETEDLSITHYEL =,

T FLOWS: Flow 4~ | ¥ PLAYERS: All~
Filter by Flow:

@ Flow1
@ Flow2
@ Flows

Flow 4

@ LAY | 1v

Blank Staves

B —LIZT7O0—%2—YEYLETT ADYIZEBDERTIEDILEETET D
[ZIE. 78—04IWEB— A2 —TFTON—hIEZAHDHE (Blank Staves)1Z&9') vy
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LET HITTANTOIO—ZENYETHILEZRET DICE. [TRT (ANIESI)YY
LET,

JA—REL: L7 TLavTlA7oMI7O—RELEFERLGEVIENTRE
SNTUOWTH LA7IMNADHEDR—IZo0—RELOEEZERAL-B &I,
ZOR—=VI270—RHELOEENRTINET . EEZLUBOR—JICHLERTS
HEDEBEIL. LBEOAR—J(270—RHELARTINET,

FE2—D5Tik

FHA—RURDER: EFELI-ERDOFI—AUFEERIZDLRIF T, FTITELLERTE
TEDIIINLBYEL - FFEZFTRDOEIIZ, ZRUDFRTYT ($F) DRUREDER
2. BACRZDHDAUEZERITONFET

w ie = B 5 PN N
- A - - I~ > /-"'.
w4 E = = = he fe ‘:’# he #.ﬁ e i 2 he
"ﬁ'ﬂﬂ% I = d
o 8 =
¥a ¥

_J ¥ 'f’z_j full J
- = } 22—‘) {22>J {22)
—_— =
B

BROERICEITAFXFI—AUFDOEREICETEEA T avhBmEnEL, C
NI AUREDEF OB T S LYRIIIRNURZLEOH LD, ThitiEFTES DN
BIERET EMNEET AT aviaEnhYET, BRIFRRESDONMUICEET HE. N
UREMEORLICAITTERBIEEEFTH. LUBDOEEARDAR—IADNBE
[ZRYET,

EIS—r7—LIZ&DTavT  R9—T . H&UHF (T Dorico TlE, TLFF2—D
EJS—h7—L (BIZT7—3—N\— FLEOT7—LELEENFT) ICLERL—HE
BIETO=v%  BEICEEE TEHLIITHYELT,

SATEERMT HI(E, EHEE—FTIEMF (Ornaments) 1/ R ILD %
¥ X (Jazz)1eoarh @t RV E#FEALTI+—ILRL—X
ZERLTH S, RL/ARIILDIFE— (Guitar)1 £ 3a> DIETS—k
IN— (TAY) (Vibrato Bar Line)J/Ra2> %91 voLTlw/bar IOIETR DﬁB?
LB EEBMT HH ., [Shift]+[0] TRAKRYTA—/A\—IZTwbarj&EA R
LET,

-+ FATE)I—EERTBICE. FAT &M o8 /FE)2—
O3+ srum. tOMIA—FIrEhBEREANLET.

[Shift]+[0] TRIKAy T4 —s\—I=Tvibbend ] EA AT BA, B

00— E—FTIEME (Ornaments)l/#)LOT¥4— (Guitar)lt
B 92avIiHBTETS—rI—{FEDF2—AUF (Guitar Bend
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with Vibrato Bar) R4 ZFHALT. 2 DORUREERLET, =, TO/NF4/8
FILDIFA—RUE (Guitar Bends) DY IL—TF(2HBTETS5—r\—%FEA (Use
vibrato ban) I TANT4EFUIZTEHIET. BEDANUREETS— L7 —LDE
FAENBRURIZERT HEBTEET,

TVEATH#ERTBHICIE. TANRTANRRFILDIFE—FTH=vY (Guitar
Techniques) DY IL—TTIRT42 T DEFE (Pre-bend interval) IO TR/ T+
EAUICLTITIRIRZEERL. TEOBREZIEELTHSIETF—FA—RUT 1Y
4 (Vibrato bar pre-bend) 1D T ONTFA4EAUIZLET,

RO—TEEATBI=E RAI—TERRT SEHERRL. vV
M8 (Ornaments) )/ SRILDIF4L— (Guitar) 1oL ay —F—F—1—
DFEYNERALED )T Bh, [Shift]+[O] TRKRYTA+—
/N—IZTvibscooplEANLET , Twibar JIDEREESZEM
THEEIE ERESOERERREZHETIFOEHEBEZTEIR
L.TEME (Ornaments) INRILDRLEI LIV DIETS—kN— (FM4Y)
(Vibrato Bar Line) IR & FEALET,

s L5l 55

op=-

VOV ST R R BIE. v T AR RS BEBHERRLT
A e e — — F&EMFE (Ornaments) /AR JLDIFE— (Guitar) 2o 3>
© “'”’* OBERHRELES) v T BN, [Shift]+[0] THKKRYT4+—
V V V.V —izlvibdiplEAALES , DB E T, FoyFI2iEE

9076 2597 (%) OBFEAERASNET . 1 RTvT (28) 218

B2

= R BIZIE. TavTE2BIRLT,. TANRTANRIILOTEHT

(Ornaments) 17 IL—T12%H AT LD EFE (Interval above) 1D TO/NT1%ET1]1Z5%
ELFET, EVFEREEIGVERLI-TAvTEIERT HOIC. RGO B FEE
MCETHZEE. T#RE (Edit)] » TFFEE (Notehead)] » MIFMELIYEZR
(Toggle Round Brackets) 1% ®iRLET,

R R TIRETIS— NP —LDEEBAIBEICEEZEZF AN, ChIESED
N—=D3UTFESINTLET,

EJS—F7—LDBEBREEDT IAIMDAECREICEAT 4T avik, #ES
TarDIFA—TH=w% (Guitar Techniques) IDR—IIZHYET .

INUR—AETILAT: Dorico TlE. N\UX—FA D ETILATDIE R BE 4T
BEROEROMAICRIRTEDLSIZHYFEL =,
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THIETPIDR—IIERRETICRT—ZFEERAL TN\ I—F U ET LA T%IER
TH5HEF. BEDAHECRTI—ZERTHETTHATYT . ZTDHEE. RT—Dxt
REGDBREBRLTSIEANLES . BFEDORT—ICTHIF I TPIZEMT 5
BEIE. RAS—DTWEBHEERL, TONTFARRILDIEE—FH=yH (Guitar
Techniques)1DT IL—TZH B EEEE (Technique) IO TA/NT14%EFIZLT,
[\><—74> (Hammer-on) 1M FILAZ (Pull-off) JIOWWF I EBIRLET,

THIFIETPIERS—DEAZ 1 EORETEMT AICE. ERBEEZERATSE
FFEF#IRL. [Shift]+[O] F—FHLTEMBTORYTA—N—ZHE. N7 —F>
[Z(XThammer jEf=(&Thol, FILAZIZETpull1FE =X TpotEAALET, Thpl.
lopol. Thammerpull), MNiglEf=l&lMNigadolEA DT BE, No—F T ILA
JDIE RS ERIFFICEBMTEEY,

FEARETIE RT—DMFTWFBERFOFRRICTHIFRIEIPIA 1 DRERESNFTH.
EEFICTHIFEIPIZRTTHBAREF. FEF T av DI F2—FH=v)
(Guitar Techniques)IOR—C T IBYEASBERLOXI—TI=vIDHNE
(Appearance of guitar techniques on adjacent notes) |ZIZEhENDEFICE
& (Show on each note)JIZERELET

NIR—FDETNATDIETREESOMEF. TANTA RO FE—FTH=v)
(Guitar Techniques) 1D IL—T (2 H B BRELEDERE (Technique placement)]
TONRTAEAUICT HERMTEDLIITHRYET,

AyELY BIRLE-ERFICHL T ATREBTROEROMAICSA NI REL TR
RDAYEV T HERRETEET  AVEV T DERREEFALTER T 5 HEE
RL. TANTARILDIFE—FH=y¥ (Guitar Techniques)IDJ IL—T TR
EH& (Technique) IO TONTAEAUIZLT, SAMNUREAYEL T DIFEXTAY
E>Y (Tapping)l. LIrNVERYE T DIGEIXTEF TRV (Left-hand
tapping)JZ:&IRLET . SAMNVREYEL T (X, IR ETEAVEL T THEH
O EITINSHERFOITINEBEINET M hDYITTSRBEFITNSHENTE
RRCEET LIMUREYE LT XEIINSHBRFOITINGEESINET,

[Shift]+[O] TRKRYTA—\—ZFALTEEVEL T EBMTEET, NtapléEA R
TEHTAMNURRYED Y ThtaplEA N THELTRNUREVED Y Ttappull1F
f=zIXlMNhtappull AN T BE TILA T EMA B HSOIAVEL T NEREINET,

SAMNIRBVEL T DT IHIVEDNBREERES BT, BFEF T avDI¥5—T
9 =% (Guitar Techniques) 1D XR—IIZHBTEVEL ST D48 (Tapping
appearance) DA 73V Mo EDNERZERLET,

ATEDRTIERT BEA T30 DIEEL—FTH=v% (Guitar Techniques) JD~R
—DIZHBIFLWA T av [ F4—FHU=vH% R (Show guitar techniques) 1%
FALTEROERILRTTDIERTEICLIZEE. AVELT . N\o—F2 TILA T
EDXR—TIZyIEFTEIZARITT EINEINEIRETEET,
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AT ALERT: BROERE—EICRTTIFITEIZHDIALERTTEDEL
SIZBYELI=, LAT IR T30 DI TL—— (Players)IOR—J(ZH BTy
FEEER (Fretted Instruments)IDEI 3> T AT REEFDRERE—FEICRTT
BENEIMEHLT, 3T X LEFRTR (Show rhythms in tablature) 1&4 >
[ZTEDELSITHEYEL,
IN—=TORF)TG

RIEE®D 2 5% 2 Y —bN\—TDORIEFD C 3%&& D %Ik, thD LIS L TIXEYF
FLTSEBEIRAINDEEEZITEL A TD=OINLDRIE. N—TEEZNES
BICFa—=2F L THEDELHYFET, LT=H>T Dorico TlE,. RFEIILELEDETE
EIESIEEN—TDREED 2 KIZOVTIFEESINT . 20 2 KITOVTIEELH
DHRTRRINDIIELHYFE R A

EERSLKILRES

TLREES: FEAF T avDIERREELKILES (Holds and Pauses)|OR—
IZHATEERIE (Vertical Position) Do avIz, HiLWATLaVITLREE
DEERIE (Vertical position of breath mark) 1A EBMEhELz, COA T3>
ZEATHE. TLRARBEDMERHICADERNEFRALOEFOEYFERIT
OMEINEIRETEFT,

AVRMGIARDEALT

BREOTI— BEDTFT—DAVARY LAV F=IZBMEIhEL-, SR
CRILEYFTHRAIN., A V93— BAMESERESOBATRLTIFHLLNATY
AVEHETOFEAZINRELTVET 42 R—COIFHES INIEEZSBLTES
ll\o

FRDF1—=2T: MEREDIN RADF1—=7 M RERL—BRMICHERS
NTLS G3, C4,E4 [TRRYFELT=. {aHil7: A3, D4, P4 DF1—=2J 151k
EFATEET,
o2

HEERORBEEDRE: T/ T1/IR)LOTHEER (Horizontal Lines)1D4J )L
—JIZIKEBAMRAIE (Horizontal start position) 1D T/ T4AFH=IZBMENE
Lize COTRNTAEFERTHE. SAVDRBMEEFEOLICHIZSH . FFED
ERIORFFEESIHIZ SN EIEETEET .

H5—: BWERIZTHS— (Colon) 1D TaNTFAHREINTNSIHE. ThERRT
BHFEITGYFELL =,

MusicXML DEZEHL
SRE9EE S MusicXML Z#EEH I RICEEN SRR DEHENLIAYEL=. BE
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RSB DL /A=) —D 55, EREIZ MusicXML [ZTHR—FENTLNDED (EH
BYRBNET , ¥z, BBERBET IV —2aV T EICELLFETUEINET,
Z D1z, MusicXML 774 ILE BRI T TV r—avIlBEarA AT, 52558 S
DRELETHSIZEESETITOHLETS,

IYY T A IA—FIDATEUN MusicXML DEEHLHRICIMAONELE. £
= ATEVICRBOBBLHERLIBEDRAI/ILIMERINSGE. COFEHRLIY
d—FENdK32HYFELT-,

FEIMT BERICUHBRTCLEIELGLIFTENFEFAINDEE. COFERD
MusicXML IZE2EFHINBKIITHYELZ, ThIZE, BEF T3V DIEHR
(Notes) IDR—TUTEIRTED 7 MOMKDO L 24T /—FDARRDYR—IELEF
NET,SHIC, FEICEEZDHAS—ZFEALTLSEE . TDHF—H MusicXML
[CTHRR—FENFET,

TR BIEFDTUREEEFERGET R MusicXML [TEEHEIN D KSI1THYFELT,

HFES: MusicXML [ZIEZTEVZAM L, AVEOE 24 L, BHBFEES (senza
misura ELTEEHL) & SESFLHHFEREDNENESHIN S LSITHYZEL
1=o

EmEIRITRR ITEBZN MusicXML [TEEHINDKSITHYELT, ITERFZT VLD
—REEICKDRTIANT FIEFVRELTIHRODNGEWMER DITEIZD—#RELIZELD
RRAATERFRIZ, FTEBF YLD 5 REICKERTIATHYR—tESnFELT=, 1=
=L, MusicXML [LFERBOBMN AT EDITEIRT ) FEHR— L TLVEW 0, J
JyRDRRIAATEFERATEHEIMNE DHOYIC 5 REDRTIAMTEFERALTESE
SNFET,

MusicXML DEEAIAH

SEERUE: Dorico & MusicXML 7ML o T XA —ZADBERBETRAIRAH .
pizz. 1 ¥Tarco ] D KSHIERIEEF HFMICHRAHRAD D ESITHYELT=,

TXRNTAT L REFREDMusicXML DFEAHAFA (MusicXML Import) JDR—
DIZHBITHXARMP AT L (Text items) 1A T avh IR ETAHUITGYFELI,
URTNZZDATLavEFAUICLTA T, THFAMLTHEARAEN-TURPZDMD
I—IOMN. RO BEEBEREE OTATLEEE T DT — AN ST E1DIZ. 47
[CLTLFESEIGHEENH NI, £I—EAUICLTHTLIZEWN  THFAME R AL
CEDEBEDAIREM TR T AMEENREESNFLT -,

EBHOTL—T
B4 Ty THTHEY, HORDTRboRICKBANHEER (Notes

starting on a beat following a rest in the beat) QA T ar M, LA T a>D
BERHDYT IL—TFE (Note Grouping)IDR—U(ZH AT F NG HYFET- (LD EHE
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HFEEHE (Simple Time Signatures With or Without a Half-bar) @532
BELELz. CNITF/NEFOH AP FICEH. FNEOLZWEFICHRZRICERIN
HILEBREIZT =TT,

FFER
BHOEEEFERATINEINT EROREEERALTHEIMTEHETHEE.
[FFEEZ#RE (Edit Notehead)IDF A TR TAH Iy £iAEIT52ET, FEICH
TEHMEDEREAEEEETESLIIRYEL,

BEHOAR

ENTOERIZIEE): THRE (Edit)] » MEFHEEAEY 11T+ (Paste Special)l » T E/TF
DRIZFE) (Move to Staff Above/Below)JZFFEAL T, EFHNDZFFE LTI
TORERICEEHTHHEE. TOERTERNBRSNTOVEKTE BEICIELTH
BADERIEFMERSINDLSICHYELIz, ChIZkY ., ERETITUTILE
BETIEDFHER)XLDEILEFIETEET,

N—hyiareyF
E4: TB4& (Play)] » I/8—hviar<yZ (Percussion Maps)|D/N\—hviay

IYTDRIEBRIZ, MIDI /—hFonN——#ICEREFVE—T (G411 E) NERT
INBESITHYEL,

B4E

FH—AUEF: Dorico & MIDI EVFAUREFERALT, F2—AUREBEIRTEDLSIC
HYFEL =,

v XT7—T14F¥2L—32: Dorico (&, SBELDOYXT—TsF2L—arEN
—FVINAVRARYIAVMIREEN TV EREEERO YTV T FEFER
B4 (1=&Z X NotePerformer & Garritan Jazz and Big Band (&, EB5HE AL
Ox X7 —T4F2L—2aVBABSNTUET) ITIVEL T TESKSITHY. Th
KUY X7 —TaFal—2avaERLELLEEULGBERADOESREENH S
NnBES1T75YELT, Dorico DREERBERKIE. DY X7 —T1¥aL—23
VIFBRBERTIELWT B Y R—FLTOER A,

A—H—HEDIVRT Ly avIvT IO XT7—F14FaLl—arv DY R—+%
BN 57=%IZ, Dorico Mo AESNEZBERDERREK. OvX7—T1s¥%alL
—avBEREEHD—BILTWET, XA ED Y X T —To4FaL—av DRY—
TIF. BERADEREZENDIRY—T (Scoop)lIZvyELTENTLNVET,
BHOBRTOROLT—&RE: BEE—FT. EBRLEEHOEFOROL T4—
ERETELSSIHYFELIZ E7/A—ILITA3—THEHEDEFEERLTH L,
ROVFA—L—UTNTFNDODBHFDN—F )V oFE-IE9 )T URESYS LT,
MEDEZANLET . BIRLEZ-EFIARTORAST—D, Th T OEXEEL
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HELE-FFELEESINFTT . BIRLEIRTOBHERCARAS TA—IZHRET HIEE
. RALTFA—L—AYF—DRAEVRYIANSEEIEELET,

EVvFARURDwE: A —bA— 3> L—>® MIDI OV bA—5—DA=a—([ZIMIDI
EvFARUF (MIDI Pitch bend) D& B A FifzITBMSN., $/EY—ILESIY—IL
#FEALT MIDI EYFAURDT—2%EBMTESLSITHYFEL, BEFRATIE. EY
FAURDEHEEERTHILIETEEFRA. TDH  EVFARURORKIEIL. &
EIHEHROLET 1 ATYTIZHIBEINET,

HALion Sonic SE & Steinberg Library Manager @& #: Dorico 3.5 [Z[& HALion
Sonic SE 3.4 & Steinberg Library Manager 3.0.25 M{tELTLVET, Chbnay
R—RrDBN—230 B TITAV A= LSRN TWNSIEE (. FLLVA—2av(C
FOTHBMIZEH INET,

aokrA—5—0DUtEyvh REREDIBLE (Play)IDRXR—C THAZELETSHEE. O
vha—5—%1)tykLTIAIl Notes Off |1%Z1%51{E (Reset controllers and send ‘all
notes off’ when stopping playback)1Z#4 I 5&. BEFELELI-EERTF v
FILDEYFAUREHEMTEybENdKIITHEYFELT,

ARO/ =LYy BEATa DI 91)v9 (Click)IOR—=2IZH LA T3y
598 7Avy% (Wood Block)1ANBMENELIz, SNIZKY, ANO/—LDY)vY
FTUICIFEBEROE—TE. BEEOTOANIIYIEBICMAT, TA—RTAVI1
vk TavID Y IUREBIRTESLSITHYELT -,

BEE—F

A —bArA—SarLb—r: BEE—FOA—FA—230—2I2lE, a—F—HAEMLT
BRHEA — A= 30 T —2I2MAT. BEDICBEFNICERSNS2EDELR T
ShdES512HYELT,

F=EZNE AR LAV E A FZHZDFIEIZ MIDI CC 1 ZFERALTLSIES.
CCl MFA—hA—2avL—r&RTTHE RATICESTAFEFN-BBESEHRT
5-OICEBBERSNERET—2CMAT. BEF T avnIABRES
(Dynamics) IDR—2DEa—TFA XERENELHMBLELEHERTEET,

[$REE (Draw)]E =51 (Line)IY—ILEERLTEMNLI=A— A= 30T —4
DEEIE. BENEVNVETRRINDELSIZHY ., BEIERShE=T—42&HBILOT
HYELT=,

BEEEL—Y BEE—FOERBAL—VOEEITRORRA U 4—EEhE L
FIZRTEINDY—ILFYTIZIL, Dorico NERIZAEITHOTLSIBAERIZLND
THRERTELEMERNRRINET . FHFOIIRT LY arIvT DY RN
MAT. TOTATEERRE. TOT4THEERD MIDI T7x9k (REYh—MZED
J—rREDEE. 7UEUMNIKEIRALTA—DERLGE) FRPD R vFLEEN
RRSNFET,
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BHOBEHTORNOVT—iRE: BRLEEHOBHOROLT—REEZ 1 ED
BIECTTHBADLIITHRYELZ RAL T —2RET HERNEREE—FTEIRTS
M FELEBEE—FOE7/A—ILIT13—LTEREFSYI LTEHBERIRLET,
RIGERLIzFHLASVTAHLDARAL T4—N—%H)vILTRIYT T 5L ERL
EIRTOFHFOANOL T —IRESNFET,

IW—5—ADIMEHES: BEE-FDIL—F—IZRRSNDNEHESIC, NEHESD
EERTIIRZIMMINRBRENDLIIZHYFEL=,

HRI€E—F

TN LD RX—LE—F: RNIZHARBIE—RIZPVEZ-EEDTIHILEDX—LE
—FM, [IR=DDIF (Page width) 1 TIEGELKI£R— (Whole page)lIZE&RESND
J::)(:fd:")ibf:o

TV A—ERDINE: OS [TV AR—ILENTWS T U A—IZERTERLVIRED

3D (FEAEHR—LRYNT—ITIIFERTELRVBSEREARAYET =D RV T —H

TVoA—  FIFBIZERNA I TWS T A—1E) BN 1 BUEHDBE T

) B—DHREIZR T AEMINED =D DT A—RSAN—DREVHLANZA LT

Db BETHLILIZKY, Dorico DEENIZZKRTBENRETIHEENHYEL:,
BREDL, COBETY—R/IR—T1—RT) A=A N—DFA LT IREMEMN

FERETRETS-0. TRITRETHIEETEFEA LML, BEFIZTI 42—

BREUNET D LE0D, EEEYIIVFICHOTHRIE—FICUIYEZ 5213

T TOHERREFEITTHESILI=CET, BRIFIBRDEENIFTIEAL, ERRIC

RS 2ENHIEEIZDHFREET HELSITHYEL -,

ZM1= . Dorico DEENZ MO TEHRIE—RIZYIVE Z-&ZE,. TATLRNA—N
RRSNDIGEELHYET,

Yn—4IL3w—o

HEOTOUN—FILI—7: HEO—BTOEROTICUN—FILI—Y%EMEK
RIBIZIK, LATIA T a0 IR EMEER (Staves and Systems) JDR—(Z
HHE—EBTDERDTIZHLERTR (Also show below bottom staff) 1T, )/ \—H
JLY—% (Rehearsal marks)1&4>I2LET,

HMEDONFRETALZIN—YILI—0: FEFTaoDTYN—Y)LT—9
(Rehearsal Marks)IDR—U(2, FLWA T av B O /IMNI#RELATZ) N—Y
IWI—IDKFEATHEYE (Horizontal offset for rehearsal mark aligned with
systemic barline)1AVBMENFELI, VN—FILI—IHHEED/NETIREERIZ I
BESNTWSGEE . SBRORAICHIERIE. EOFEETIEXIYN—HFIILT—UHHE
EBDINTHREBERET IBNALH D=0, COF Ty BERINET,

ﬂ%l:

EE—F
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FLWRRBToH T I oYU TILOTLEESR (Strings)1ATI)—IZ 3 DD
LOWITEyb7oH TR EMEN, RYTRORECA DA — ARSZITHERS
FIELREREILAVETIEPGEBMTESLSITHRYEL,

AI—

RYPYEFECRT—: BEF T3 DIRS5— (Slurs) IDR—IZH AT RIGDEIE
(Endpoint Positioning)1Dt7avIZ HLWA T3 TREYOEEIDRS5—0
BEMBEZEBIE S (Interpolate vertical position of slur either side of break)
MEMENFELIz, AT—MHEBERUYEZFCLE MERTIYDFIZH AR Z—HI
FORAKF. HERTYDEBEDOIL—XDHHRERET H5ELDTHLIDHNEBMTT,
FNIZKYTL—Y—IE. ZDTL—XD2EELTLRTEINTRET S0, Hohl
OHBEMNTEET, CDATLAVEAUITTEHE RST—DREDEFFECTRME
T HIF DA FEERUYDHEN LERFOEHR FERUIYDR) OEBEMEM
BEYICHEEISNET,

COFLWA TS av(E, FRERESN TSI TCREAVICHEYET M BREFEDT
AYIITRAIIZEL>TVET . chlE BEQTOC I ILONEN FHE BT
EBESINDEERST=2HTY,

EREFCRT—: BEF T avDIRS5— (Slurs) IO R—T DT 2L D B8
(Avoiding Collisions)]tEZ22avIz HiLWA T a U [EREFCAT—DE|C,
BERAMNEREF-CHBEZRBIES (Determine curvature of cross-staff slurs
using point) 1A EBMENFEL =, COATavd, HERRYIYDHEIEDERTRS
—ZLUERICERORNICAHOESILT, HBREFCRAT—OBRKREHRELET .

COATavF EBEN=TAS O TREAUVICHEVET N, BEFEOTADHIRT
[FATITELTNET . il BRICHEDWERARZEF T EREREFTCRAT—D4
BNEDLLLEERST=-HTY,

HEDODRAENEETIEREDUCRT— BEAF T avDIRF— (Slurs)|DR—
T OIREDAIE (Endpoint Positioning) 1Mo avIz, HLWA T a  TBtR AL
BLRTHEBODEFOREDRAZTAFNDRS— (Slurs starting and ending on
notes with opposing stem direction) AV BIIESNELTz. SDATLavIE. UTF
DEIFIRRTHRERELET,

LEDFITRERAS—DAEFORNICU21YER>TRIVWERA CCTHIVav el H
BRIOKIHEFEDALICEE (Position stem-side endpoint near notehead)]
[CERET DL ALKRRENUTOLITEILLETS,
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COEIFRRIE, FERDDOANDERANEFNDRAT—THLRELFT . CNIFFE
DEENFITEHENZL LRDRENENILENE, AF—[FRFEDFNIZE
YEREITRIRIITHYET , COFLLMEREL. FTRER SN =T 0o /TN
BETAUICHYFETH. BREFEDOTADIMTIEA TITH>TLET,

BEET—RFTORT—DOREE: [H/N—23>TlE, YIRS YS [Alt] EARF—IC
KBFYTEITESIE RT—DENURILIZERIZBELEL-H. [Alt] ZHLELS
RAS—DOWTNDDIVRRAVEDG) VI TURRSYT § 5L RS—2KD LK
INSEUVEERSN, TURRA UM F %arkrO—ILiRA VDA E [EREFSh T
Sl =n

A—H—DBDT—FN\YIIZIELTINIEERIN, IDRRSYTEFEALTH.
[Alt] EARF—FFALTH, BICTURRAUE—REICa A= LRI DB ED
FTEHRSIHYFEL=, DFY., EBEOMDIVRRAUMEEDKSIZHBEILTH, ®ib
TH5IAVMA— LRIV B RICBEILET, f-fZL. AV FA— LRIV MDD NUFILE
BRLTHYDEREIRSYT 5L, TURRAUREFBITaAV A= LRI &S
BTEET,

FEMZEDERORERIDRT—: BEF T3V DIRT— (Slurs)IDR—TIZHSB
MEIFOAIE (Endpoint Positioning) 1o avIz, TF#ftERENDDKELT
twhk (Horizontal offset from stem with flag) J&THSATEHFEINODEEA T
whk (Vertical offset from stem with flag) 1M 2 DDFHLWVA T avhBEMNEh ., 7
BRICEREIN-EEDRT—DRHREA T yMEZIEE TESHLIITHYELE,
CDEIGRT—IE WEARE T4 N EFEFELE 2 EREOFERMDRS—ITiA
WMETEEESN D KDY FLE=,

ATI—¢Talb—2av D7 —T4Falb—av: BEF T a0l 7—T14FaL—>
3> (Articulations) IOR—J(ZH BT RS5— (Slurs) I avIz, #FHIiLWLWA T3y
[RS—I2FTBREYIh—F, REAYATAYVE, TX—LDHLE (Position of
staccato, staccatissimo and tenuto relative to slurs) 1AV EBiISNELIz, ZDF
TavEERATHE. TaLb—2av D7 —T4FaL—arvERT5—D KR 0 A
[CEETAINMUICERET AN ERETEET . TONTA/IARILDI7P—T1F2L
—<3Y (Articulations) IO FHLWLWTAONTFATRS—#K DA Al (Inside slur
endpoint)1ZAUIZT 5L COBREEEREMTLEEETLHLELTEET,

MPREDRSI—DTHA: RS—DFEF TV DPHMREVIHRESN. B
AOPRIFLENPOEDODRAT—AERENSKIITHYFELT,

#% Fro 07
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MRZEBUBATE BEA T3V DI ER (Notes) IOR—T(ZH LT FE (Stem) ]
I AVIT FHLWA TV I FROEREZEYDSRTIR: n AR—X (Erase
background behind stem with erasure of width: n spaces)1A‘BilEnELT=,
NEAUITTDE FREEZHEUBIATEVIEL 2 DI ATEVEREDIZIFE
ABIZRHARITH T IVEREZEECSHISITHYET,

FERb

THRAME 1 DOLATILTOHRTR: TXRAMIEBDIETREERED/A—NEIZD
HRRLIEEFEORATICIEIRRLEWIENABELGEENHYET . (L. T+
ARTATLEERL, TANTANRRILDTTERRE (Text) DT IIL—TIZH5HLL
TONTATIERTR (Hide)IZA UIZTHIETRIETEDRIIHYELz, THERRT
AT LIFREDLATITIEHERTICGYFET N, DT RTOL ATV TIEIERT
SNFFEFRITRYET,

BEEBSDL—I2: — RGN ERES ABREELUNEREBETHFANATL
[ZRTT B2, {@gClef@}. {@fClef@}. KLUV {@cClef@} Dr—H % {FH
TEDLRIIRYFEL =z CNETHFRAMNRERRFCE V)YV AZ1—Z2FALT. [
E25 (Music Symbols) DY ITAZa—m B IRLTHIBATEEY,

HFRE

HFEREZEEY D21 FEX T3> DOMAFES (Time Signatures) IOR—(Z
HBTHALY (Design)loaviz. HLWA T a L [#ERADBFITENER
EYDSNTIE: n RR—X (Erase background behind time signature inside staff
with erasure of width: n spaces) A BMENEL =, ChEXUIZTHE. 21 DHY
BRICK > THRFESOHFHIEINGEVESIC BFREEERETH24H 2 DIH
glEhExzd,

EF

R TA—IN—DIE: EFDRYTA—IN—IZANTBLED 2 DO#MFERYS
. 3OV DOHIDOYIZAR—REZFATEET , chlTF—FR—FTanrAAALIZK
W—EDEEFZFALTLDIEEIZERNTY,

A—HY—A2B8—T1—X
BHIEMDH ALY T —: Dorico 3.5 O TEITTHEE. [B/N—2arvhoBHS
hf=CeREESnt=1548 . REE—F. BEE—F. FEET—FBLUBEBEE—FIC
VOTTIERTREEHBELAARYT—RRTSN, ZD/NA—23>D Dorico D#F

BRELREBRZVONMENLET . [AIILT (Help)l » TEFIREY7— (What's
New Tour)]ZBIRT & FEDE—FDHANYT—%35—EHERTEET,

FTaonF 4705 Dorico D 5 DDA AT aoDEA470T (LAT o047
AV BEA T Ay BEA T AV  BEA T AV  BRAALT T BEUV
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RIBERTE) (T ART TR T ERRITHIET HEIITRYFELT=,

EFATATDELABICIE TN I—R/ERVIZDBHYET , T1ILEZ—RYIRIZT
F—hREFTIZIL, [Ctrl]+[L] (Windows) Ff=I& [Command]+[L] (Mac) Z#LFE
ER

TANE—ICEEDXFEANTDHE AR—VDBREBER—DDEI 30D AT
EDTYFICEYENEICYAARYAENE S  CNICKYRMEDR—UFEFEIY
IVETIERCRDITHIENTEET , HHIC 50 R—TUFBALHEEA TV TILE
FTI,

BHIDR—IF R DI, [Tab] F—EBLTI+—DRZETAILI—RERYIR
MoBEL T, [Ctrl]+[F] (Windows) F1=I& [Command]+[F] (Mac) ¥ &5 470
5 EEICRBN—DRREINFTT . FIIRRBEEANTHE R—CHNOBRRET
BAFET . RRN—IZEIYFHELRREIN. 1 DODOTYFICENEICEELET . X
DIERIZFEEIT BIZIE [Ctrl]+[G] (Windows) FE7=I& [Command]+[G] (Mac) %. &
D BICH E I B IC ([E [Ctr]+[Shift]+[G] (Windows) F 1= I
[Shift]+[Command]+[G] (Mac) ##LF T, REHKREI TN ENTFRAIDE R
DEREICKYSERRREINET . RN —ZFALSIZIE [Esc] ZHLFET,

AT FAT7RTNOBRRIZERTHXF—aTREERTH5E(E. RERE
(Preferences) DI F—HR—Fa—khvk (Key Commands) | OR—P T, aAvUR
—EDIAFoar 4704 (Options Dialogs) IDATI) —CRETE=ET,

EEE BEREDIEM (General) IOR—TIZH LA T avnEmMSh, ZILR
A7 IS—b . WRBLRATDELATIMIARZLDR—VEERERETED L
SIZHYFELT =, FREE—FEEFEE—FIZE, HDRFLDEREI ST—avEl
ATES&IITHRYZEL,

re layouts: | )

Part layouts: #fef2da >

ustom score layouts:  fffff 5

Use: Single Color Preset: Juicy Cake v
Stopl:  #eldfad Stop2: | Heldfa stop3: #fods2s [ Stor4: sediz [

Single Color

Stopl:  #azbedf [ Storz: #a2bedf [ Stor3:  #ebScce Stop4:  #0c3483
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[F1)tvk (Preset) JA=a—h 5, TH4F— Dima Braven KIZ&% WebGradients
avyiavholohfz, SEESFLEBHHBEDT T —avEBIRT M. 4V
CHLDTST—avERELET . WTADODBDODREEV)VILTHAS—E YD
—ERRLFLLWAT—ZFFBIRT S0, VEYERNZI)YILTHS—2 TG HER
DTIHILMIRLET,

BRITUIT—avTIRE<KERZFERT H5E(L. [BE (Single Color)jZ4IC
LET. ShIZKY. TRFYT 1 (Stop 1)IDANITERDRARUSN TESIZEY, 22
THRELZENEREARIZERINET,

SATSN)—ITT453— FEAZ21—DWOIDFATRAYT (INSTS57RE4(I)L. X
FRAL) ., EERE. FEEYN BERES . O—FFMT7ITS L. SAVI T3
E) T T7oavn—nEr74ar (B) £#9)v0$ 5 ETERLIZIEBREEZT Y
AILRELTREL. SEROTADIMNCHERATERET . EQOT AT LT IAILREL
TRBESNTLAND MY OIS 2012, BEINETFATLDEEEYDREH
T (M) ERINFTT . RELETATLETIAILIDLHEIRT 521X, BT
L5—EV)ILET . TAAVIEAKRERTRICRYET,

Ea—0#%E: BREFCZTOMOBENBTDEEICISLTEL—ZBE T HHEIC,
ZLDBERAMZLNFELT =,

» XL —Ea1—R—TDE21—DVWITNTH>TH,. EADBERFITERLL:
TATLDNHENT-MEICRITIINTWDIGEE. BICTATLNREICAST
NEEREE 1 —DBET HLIITHYELT,

» FyL—Ea—THEIITSHEE. REDERGBENFER LTS TO—L&
FELGHT70—IZHDHE . Ea—[TEICHhDIO—0:BREFHREFICAS
MEFETHET HLIEYFELT,

» BIRLETATLO—HEITTEEA—IZCASTWAEES. TENHABEE D IHE
YEYTHH>TH. E2a—[EFDT7ATLICEN>THELAAGYEL . BN
—2av Tl EBRUETATLNRISGEWNVES . PTATLERRICFESES
[CEa—ABEILTLVELT,

= [#R:R (Edit)) > ITO0—DFREBFETREIR (Select to End of Flow) JZ:EIRL
BEHE  BROR—DICEALRELFIRETHSBIC EIRERD
EDBHRTERRINTWVSE S, Ea—(FFE o= <BELAEY ELT -,

» EAFEBDMEOABERY BRI GELTCGEREESAR—DRYZEL
EHE. BICEA - BHLTERGEEO—HERRTHLIICHYEL=,
BN—23 Tl GERSEBEANREDR—CDEHOY UBETHRIESIN TG
B BREEEZRTTAE=HICE 12— BET I EEHYEREATLE,

= [RFR (View)] B [R— (Pages)] » [Bi—~R— (&[H) (Single Pages
Vertically)1E 1<l RBAE (FEE) (Spreads Vertically) 1hSEIRSNW TLNDE
& [Page Up]/[Page Down] ¥—IZ&kBE1—D L TEIHNEEIZTEHLN
&Y FELT =,
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LI RIDR—CDEBLURBDR—CDEICHEBRINLGEROIEMNFE/NEN
Fllz ThICKY, EEEZERICRAFTRAI/O—ILLTH A=V DIHMNE 12— D i
MoBENTLEICEMNGEYFLT,

HEE—FTORY: LEET—FTEAICBHTHLE A5—MNERSWTLHIRE
THHEICCNULRS—ALGWMER L. BEARICIECTRTE T RDOF K
FICAM>TERBDBEILES , CIZEY RT—FAALRIC [-] 2T ERD
BERICBETEEY . L. EDRMEDRICAT—NANSATOLEWNZEIZRY
FY,

HEE—FTHELAZERLTVSEA. (1] ZHTENETO—FLOENERS
NEFFIZEY (1] 2RI LEMBO—BTOENBRSNEFRITHBYEY ChiC
LY. EVFEERTH-OICNBOELRDERBEERTHIONBEHITHVET,

BFERANY—ILRYIR: EVvFETaL—av AN DORIIEE T 5HEENE
mEn, BEE—FOEBFAAY—ILRYIANBREINELz, BIZCEM
[2H2 TS 4 DD Y—IL (TBIR (Select)]. [EVvFETaL—Lav DRIl
#§%E (Pitch Before Duration)]. Tf1E#% A A (Chord Input) ). NEA
(Insert)]) [F. /3R D EBBIZRKRRENDKIIZHYELIZ, Y—ILIRYIRD
BYD 8 DDY—IL. ZELTERNARILOIEHFOTaL—3> (Note
Duration)J/R422 | TEGEFEEE (Accidental) I RFV B LUV P—T1FalL—>
v (Articulations) JR2U (&, MEDIKE (FrLyrDRRSNTNSM. 7
AT LHFIRSNTLDD ., YVRAADBEIGE>TNDEHEE) hoFIEL
T. BHEICEENHHGEEICOABEMIELEINET,

INERDIBIN: FEEEEEBMMT BRI [Shift]+[B] TRKRYTA—/N\—%{&
FALT/MEIZEMLESET HE IBFEBZEMT 5. hhUIZT+12ql73E
DEXEFERALTT2L—23VFEMT5EL5KDIAVE—IUNKRREINE
9, FHIZ. AFEBMT BETIZM/ME&/ME#R (Bars and Barlines) 173 JLDT /v
fixfEA (Insert Bars) I/ RA ZERALTIMNAZBMLESET SE, HHFCEZEM
FTELSIRDHDAYVE—UHRREINET,

F—IR—KFia—rhuk: BEZREDIF—HR—FIa3—krhyk (Key Commands)i®
R=DIZHAHAUTOHTI)—T. UL TOHREICF—HR—Fa—thybEEIYHTS
CEMNTEDSIITHYEL,

= TEHFDOAHN (Note Input)] » TTRHORAHNZEESE (Disable Mouse
Input) ], FLIEBFAAY—ILRYIZXDONER (Select) |V—ILELTHS
N5HHEE,

= [#RE&E (Edit)] > TFFRE (Stem)) » IEfEFAFKICPRIZEE (Force
Centered Beam) B S UTEN D P REEZXYE (Reset Centered
Beam)JDHERE,

= %% (Engrave)] » I#FFEEtYF (Notehead Set) |Z:&IRI BE. TIHHE
BEREDNDSATI)—TCEEINTVWAFE YN FHRERTOD /LD
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TIAIRELTRESN=FE YLD YRR REINSSIITHEY FELT=,

REDREVRYIR: BBV FO—LIZRRMEE RS E 5 LT O/
LDIE REVRYIRERIENF T, TONRTAIRRIUELVEEL T avDF(T
O TRE (BRIERR—R) £RFTSOIERTIRELRYHIRTIE. B
B EENMEEETTELLSITHYEL, UTICHESTET,

» RAEDEIZ2ZETICE. REVRYIRIZT+=21EAALET,

= IREDMEMS 3.5 #5KIZIE, REVARY I RIZT-=35]EAHDLET,

= IREDMEIZ 1.5 FHTBIZE, REVARYHYR(IZM*151EAALET,

= IRAEDEZF 2 TENSIZX. REVRYIRIZIRIEADLET,
ETONRRILOBELERESN., 1 DF-IEERDEHF—ZHLLENAS/NRILESY
VT BHENEDERNUTDEICELLET,

= BT —ZFRITI20YvY: 1/8 AR—X
= [Ctrl]+[Shift] (Windows) F£7=I& [Shift]+[Command] (Mac) LA 5Y
)49 1/32 AR—R

= [Shift] #ILEA BTV 112 AR—X

= [Ctrl] ZRLAGA VYY1 AR—X
ESERITLE 12— FIRIE—FICYIVE R 52 8%<, RIERIET S5 T499~DES
HLEF KRILKBOREEZHELEZVGEE.T¥ ()] (WN\vIRIvIa,
Windows MDIFE) F£1=I1&MM) (/\vI9+—k. Mac DIFE) #HLEEITHE. R—IFK
H.IL—LDR. TAR. AT LMY IMNIBE S FEBHS—. GENOERF
BE HRIENGEWT AT LI RNTEERTRICTEET . F—ZHLTLSME. 3T
DR ERDT AT LIETERICEHRIEhSE (BEIFR) TRERSN., HIRXARTE
BWITRTDTATLIERTRIZEYET , F—Z2WT &, R RTIEGENT AT
DT ATLDRRIDFT—ZHIHIOKREBIZEIRLET,

BAT7OT DY ARELE: TTVT—a> DEEBMSERTETIL. TRTOF (70
TOHYAXEMBEIRFEINDLIIHYFEL-, BERIRIEIBEICIE, TRTOH
A7 RIREALEEICERLEY . 7TV r—2avz R TLTEERT 5L,
YA XEMBEDREEIE)EyrEhES,

ZHILR—k: TAILT (Help)l > T2HLR—LDER (Create Diagnostic Report)]
EBRLT. TIOZHWNYR—bELETH =5 LISEETH=HDOT DT —h4T
EERT BL. T—HATDBREEZ DAV E—UDRTINDKIIZHYELTz, Ay
TR THE. FDGFTO T AL —hH Explorer (Windows) FE7=I& Finder
(Mac) TRZEFE T, 7T—H1TBARDT71)L4AlL. EIZIDorico Diagnostics.zip] T
ED

INTA—TR
20—0HMNZLNTOD I JO—DENZWNTOSIIDL A7 hEFEED L
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BASRIZEYELE, CNEZI7O0—DNEBIZTIILFRALYREFERT 5K31274o1=

T:&)—Gj—o
BEERBEER Oz IMIHLCEREEZEBMT HNEN, MR LY KIBICERIES
*Lil./f:o
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Issues resolved

@ steinberg

Component

Issue

Arpeggio signs

When using the Place items with the mouse preference, clicking on a note in a down-stem voice
to create arpeggio sign (or a vertical line) now works as expected.

Articulations

When using Petaluma and allowing accent articulations to appear inside the staff, accents are now
correctly positioned one whole space away from the outermost notehead, not in the adjacent
space.

If the option to show a double barline before a coda is set, but the option to show a double barline

Barlines before a start repeat barline is not set, the double barline before a coda coinciding with a start
repeat barline no longer draws incorrectly.

Beams Editing music in 3/8 no longer sometimes causes secondary beam groups to change unexpectedly.
Setting Split secondary beam on a note no longer influences the automatic calculation of

Beams secondary beam groupings, so manually setting a secondary beam break will not otherwise
influence grouping.

Beams Fixed beam corners in cases where a partial beam occurs at the beginning or end of a wider beam
group on an inner beam line further out.
The stem direction calculation for beams with odd numbers of notes and an equal number both

Beams above and below the staff mid-line now correctly accounts for the side with notes furthest from the
mid-line.

RO When setting single-note tremolos using the panel in Write mode, it no longer causes manual

beam breaks to be removed.

Brackets and braces

In the various orchestral templates, the option Bracketed groups with only one instrument is
now set to Use bracket by default.

Brackets and braces

Dorico will now correctly group staff labels for an uncondensed staff adjacent to a condensed staff.

Chord diagrams

When ordering alternative chord shapes for a particular chord, Dorico no longer prefers shapes
that include barres above those that do not.

Chord diagrams

Changing the tuning for chord diagrams no longer sometimes causes existing chord diagrams in
the flow to draw as empty grids.

Chord symbols

Under some circumstances, Dorico could crash when attempting to add an imported graphic to a
chord symbol; this problem is now fixed.

Chord symbols

Under some circumstances, moving a chord symbol in Engrave mode could cause items
elsewhere to move unexpectedly. This problem has now been fixed.

Chord symbols

The Appearance of major triads option for chord symbols now only applies for simple triads; for
chord symbols with higher intervals and alterations, the option has no effect.

Clef Various problems with clef changes in divisi unison passages have been fixed.

Clefs Typing f3 into the Shift+C popover now creates an F clef on the middle line of the staff, as it
should.

Clefs Dorico no longer shows a redundant clef at an instrument change if the clef for the new instrument

is the same in the transposed part layout but different in the concert score layout.

Dorico 3.5 N\—>a B
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Component Issue
Dorico will no longer crash when attempting to generate initials for the comment author from a
Comments
UTF-32 username.
Comments Selecting a comment in the Comments panel now more reliably brings the comment into view.
D : Under some circumstances, moving a dynamic in Engrave mode could cause items elsewhere to
ynamics ) :
move unexpectedly. This problem has now been fixed.
D : Increasing or decreasing the intensity of an immediate dynamic hidden by way of Hide dynamic
ynamics . X . . :
intensity now updates the text of the signpost immediately.
Dynamics A messa di voce hairpin that stops at the barline no longer has a larger than specified gap between
the two opposing hairpin segments.
Filters When using the Edit » Filter » Note in Chords filters, if a chord contains an exact unison, only

one of the unison noteheads will now be selected.

Grace notes

Selecting multiple grace notes at the same position and hitting T to tie them to the following
rhythmic note now correctly ties all the selected grace notes, rather than only the top one.

Guitar notation

The horizontal position of the right-hand of a guitar bend starting on a grace note and ending on a
rhythmic note has been improved.

Guitar notation

Typing Ctrl+left/right to navigate to the start of the next or previous bar in tablature no longer
causes a crash.

Guitar notation

Clicking Export Tuning in the Edit Strings and Tunings dialog no longer causes the file chooser
to appear twice in succession.

Harp pedalling

When copying and pasting a harp pedal change to the same position as an existing change, the
pasted harp pedal change will overwrite the existing one, even if it is attached to the other staff.

Instrument types

The transposition of the handbells instrument has been corrected. Handbells sound one octave
higher than written.

Instrument types

The banjo and tenor banjo instruments now have the correct octave transposition.

Key signatures

When editing a custom key signature, it is no longer possible to attempt to add more accidentals to
the key signature when the maximum number of accidentals has already been reached.

Key signatures

A problem whereby cancelling the changes made in the Edit Key Signature dialog would
nevertheless persist despite have been cancelled has been resolved.

Key signatures

The input string for an open or atonal key signature is now parsed case-insensitively.

Lines Note-attached horizontal lines are now correctly duplicated when duplicating a flow.

Lines Improvements to the editing horizontal lines whose ends are note-attached to prevent their
duration from becoming negative when moving their start position.

Lines When importing one or more flows from another project, horizontal and vertical lines from the

source flow are now correctly imported.

Dorico 3.5 N\—>a B
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Component Issue
- Dorico’ s user interface is now always shown in the Noto Sans JP font family, instead of allowing
Localization . .
the operating system to choose the font automatically.
Lvrics Adjusting the vertical position of a line of lyrics on a system that also contains material cued from
Y another instrument now works correctly.
Lvrics It is now possible to nudge multiple lyrics with the same line number but belonging to different
Y voices vertically in Engrave mode.
Lyrics Soft or discretionary hyphens are now filtered out from lyrics that are pasted into Dorico.
Lyrics Moving a selected lyric with Alt+</—, or pasting it, to a position that contains lyrics in other lines
no longer causes all other lyrics at that position to be overwritten.
Lyrics Lyric verse numbers are now correctly aligned with the line of lyrics to which they correspond, even

if the verse numbers are drawn at a smaller size.

Multi-bar rests

When a multi-bar rest starts with a special barline, the width and positioning of the H-bar now
takes the width of the special barline into account.

MusicXML export

Players are no longer incorrectly omitted from exported MusicXML files if the current layout does
not included all players.

MusicXML export

When a voice ends in the middle of a tuplet, the resulting exported MusicXML now includes the
necessary hidden rests to ensure the output is valid.

MusicXML import

Rehearsal marks such as F and P in MusicXML files are no longer incorrectly also imported as
dynamics.

MusicXML import

Opening a MusicXML file that reports a validation error when another project is already open no
longer incorrectly causes the other project window to receive the focus after you dismiss the
validation error.

When copying and pasting a selection made from the system track, Dorico no longer pastes break

Note in
ote Input events that do not apply to the current layout.
Note input Copying and pasting a playing technique or text item to the same rhythmic position as an existing
item of the same type no longer overwrites the existing item.
Notes The position of rhythm dots on long and maxima notes on staff lines has been corrected.
Page layout When using Make into System on a range that starts with a frame break, if the initial frame break
Y has the Wait for next frame break property set, that property value is now correctly retained.
It is once again possible to adjust the distance between the individual lines of a percussion grid
Page layout " o
when editing staff spacing in Engrave mode.
p : When exporting a percussion kit, all dependent notehead sets and playing techniques are now
ercussion )
correctly included.
MIDI note 32 in the Yamaha XG percussion map (used in the default HSSE playback
Percussion configurations) is now correctly defined as stick click (two drum sticks clicking together), not cross
stick.
Percussion Mark tree now plays back with a more suitable sound in the default HSSE playback configurations.
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Component Issue
p . When moving a note up or down in a percussion kit using either the five-line staff or grid
ercussion . - .
presentation, Dorico no longer loses track of any tuplets that may be active.
= . Under rare circumstances, adding a new percussion instrument to an existing percussion kit could
ercussion i o :
cause Dorico to crash; this has now been fixed.
= Under rare circumstances, it could be impossible to start note input by double-clicking in projects
erformance . ; RO )
with many flows using flow headings; this has now been fixed.
Plav mode Dragging and dropping MIDI data from Cubase into Play mode into a Dorico project with no time
Y signature now works correctly
Plavback If Dorico needs to transpose by one or more octaves to play a playing technique correctly, it now
Y checks the octave of the requested combination, not only the Natural playing technique.
The Suspend audio engine when in background preference has been removed, since it caused
Playback .
more problems than it solved.
Under certain circumstances, slurs starting and ending within a run of grace notes would not cause
Playback the legato playback playing technique to be removed at the end of the slur; this has now been
fixed.
The playback of glissandos on notes whose start positions are affected by swing has been
Playback
corrected.
Under certain circumstances, removing a tie from a note with a single-stem tremolo would not
Playback cause playback to reflect the tremolo until the project was reopened,; this problem has now been
fixed.
Playback Events in the dynamics lane no longer prevent playback of automatic dynamics following a repeat.
Playback Messa di voce and sfzorzando dynamics now play correctly following a repeat.

Playing techniques

If you use an imported graphic in a playing technique appearance, editing that playing technique a
second time will no longer lose track of the imported graphic.

Repeat markers

The vertical positioning of repeat count text at the start of successive systems has been improved.

With a single note in a chord selected, Select More now once again selects all of the remaining

S notes in the chord.
Selections Breath marks are now included in block selections, i.e. when you click in a blank spot in a bar to
select its contents.
The order of the instruments in the Big Band brass ensemble has been corrected, with
Setup mode .
saxophones coming before trumpets and trombones.
The Maximum angle for slurs option now applies both to slurs that slant upwards and
Slurs downwards; previously it only applied for upwards-slanting slurs, resulting in asymmetry in some
situations.
Lyric hyphens and extender lines are no longer incorrectly shown on tablature if lyrics are shown
Tablature ;
on the associated regular staff.
Tempo It is now possible to specify a maximum of four rhythm dots for a metronome mark in the Shift+T

popover.
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Component

Issue

Text

The baseline for the Regular and Italic weights of Academico was inconsistent; this is now fixed.

Time signatures

If you replace a barline in the middle of an aggregate time signature, the overridden barline will
now be correctly preserved when reopening the project.

Time signatures

Changing the Separator property for an interchangeable time signature from - to = now
immediately updates the score.

Tonality systems

When exporting a tonality system, Dorico now includes any required custom font styles and
imported graphics to ensure custom accidentals and key signatures appear correctly when
imported elsewhere.

User interface

When you use a pinch gesture to zoom in or out in a project window with a vertical or horizontal
split, Dorico now zooms the view under the mouse pointer, rather than the one that is currently in
focus.

User interface

When switching layout in the current tab and switching to a layout that has previously been open in
the current session, the last viewport position of the layout is now correctly restored.

User interface

When applying changes in the Project Info dialog, Dorico no longer sometimes incorrectly loses
the selection in the list of flows.

User interface

Under some circumstances, saving the project immediately after undoing an action could cause
the view to jump when the save completes; this problem has now been fixed.

User interface

The right-hand options panel in Print mode is how wider when running Dorico in French, so that
the translated text fits within the panel without scrolling.

User interface

The Edit » Chord Diagrams submenu is now also included in the right-click context menu.

User interface

When a modeless dialog, such as Project Info or any of the options dialogs, is open when the
user changes the name of the project using Save As, the name shown in the dialog title bar now
updates.

User interface

Typing Tab after typing a value into a spin box to move focus to the next column in the Actions
table in Play » Expression Maps now correctly remembers the value you typed.

User interface

The Custom spacing ratio control in the Note Spacing Change dialog now behaves the same
way as the corresponding control on the Note Spacing page of Layout Options.
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BE RN D Fi) RE LR IR A

FL<HHER
Dorico 2B 5 KLHHEM~DEIZEIL, A F4> D Dorico forum THEZRETEET,

FLyIOAR—X
Dorico SETEHICHAET SR RN HIMBEEMREORFHERICOVTIE, FLy
UR—ZEBRL TS,

eLicenser D7V T74X—>3>a—RDAH (Mac DH)

Dorico DHBIETEICTITAR—30a—FDANZERDOLNT=1EE . Soft-
eLicenser ZIEBIZTOTARN—hLI=TF7IUr—a0 DREHRINZRETS
[Z[X. Dorico 8 TLTHBENTIDELHYET,

BERE 1A 957—T8ATH5F—HKR—Fa—rhyk (Windows DH)

%<®M Windows OV E1—3—THEAINIZITI®RT ZT4Y IR TETE2—FF
AR—[ZIE, [Ctri]+[Alt] ZRLEASD [T/ L ]/[<]/[—~] DERENF—T, EEZ 90
FE. 180 EH KU 270 BTV T T HHEENHAREDF—HR—Fa—thybéLT
ERESNTLET,

D55 [Ctrl]+[Alt] ZHLEASD [ 1]/ 1] (X, Dorico DEFADIZEFTEEHD
1A 98—TBADF—HR—Ka—rhyrEEELET,

AVTI®T 574D R -FTETA—DHHMBREDF—HR—Fa—thybEENET
BHEITDONTIE FLYDAR—RZESHL TS, .

Dorico 3.5 N\—av B 82 R—Y Steinberg Media Technologies GmbH


https://www.dorico.com/forum
https://helpcenter.steinberg.de/hc
https://helpcenter.steinberg.de/hc
https://helpcenter.steinberg.de/hc

